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Using the School Atom

One of the first steps in setting up the SASIxp™ educational software is to 
add records for one or more schools using the School atom (in the System 
Setup folder).

As you add schools, you can also define them by entering data on grade 
levels, tracks, school type, attendance type, and so on. The way a school 
is defined determines which atoms are active and which features are 
available to users who are logged on to that school.

The first school is automatically added under the name SASIxp Default 
School, and is assigned 001 as its school number. When you run the 
SASIxp educational software for the first time, you are automatically 
logged on to this school in the current year. You can replace the default 
school name and number with that of your school, or you can add a 
different record for your school, and add other schools.

Once you add one or more school records, you can log into a specific 
school using the Change School/Year atom to complete the setup for that 
school, or you can work with it in the SASIxp software. You can access all 
school records from all schools.

Things to keep in mind

! Any setup you perform and any data you enter applies only to the 
currently logged-on school and school year.

! If you add records for multiple schools, be sure you are logged on to 
the correct school before you finish the setup or enter any data. The 
name of the current school displays in the status bar at the top of the 
message center. To log in to a different school, double-click the status 
bar.

! After you set up user records, users are automatically logged on to the 
school and year specified in their user records. They can select a 
different school using the Change School/Year atom or by double-
clicking the status bar.

! You should enter complete data and perform a complete setup for your 
school, including creating or converting data files. However, you can 
enter just basic data for additional sites. These might be sites that 
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students attend while enrolled at your school, or sites from which you 
receive transcripts. Data files do not exist for additional sites unless 
you create these files.

! At the District level, you should enter complete data for all sites in the 
district. This procedure enables you to work with data transmitted to 
district files from each site.

! Once you completely define a school record, it remains the same from 
one school year to the next. This means you do not need to set up a 
school for each new year. However, you do need to create new files 
and perform setup in other atoms.

! Each time you open the School atom, it automatically displays the 
record for the school you are currently logged on to.

School Atom Tabs

The School atom (in the System Setup folder) contains six tabs:

! Basic
! General
! Schedule
! Enrollment
! Term Duration
! Localization

Options on the School Menu

Menu Item Description

Attach School Photo Enables you to attach a photo of the school 
that displays in the photo box on the School 
atom.

Change Sch # and 
Name

Unlocks the fields in the top line of all tabs in 
the School atom so that you can make 
changes to the school number and school 
name. Normally, this line is locked to prevent 
accidental change.
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Basic Tab

The Basic tab enables you to add schools and enter basic information 
about each one, including school number, telephone number, address, the 
principal’s name, type of processing, and permit number.

Setting Up School Records

Setting up a school record consists of two parts; both should be performed 
before users begin adding data in application atoms:

! Add a school by entering basic data in the Basic tab. Mandatory basic 
data consists of Sch #, School Name, and Sch Abrv.

! Define the school by entering data regarding grade levels, tracks, 
school type, attendance type, and term type. This information 
determines which of the SASIxp software atoms are active as well as 
which fields are available in various atoms when users log on to that 
school. If you do not change data in fields that already display entries, 
the program uses this default data in defining the school.
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Adding School Records

1. Open the School atom.

2. Select the Add School option from the Data menu. Asterisks display in 
the Sch # field. This field contains the next number available from the 
Next ID atom when you save the record.

3. In the School Name field, enter the name of the school.In the Alternate 
# field, type any alternate number for the school, such as a state-
assigned number.

4. In the Sch Abrv field, type an abbreviation of the school name.

5. In the Telephone field, type the school’s complete phone number.

6. Type data for the remaining fields. Click Save.

7. Click the General tab.

8. In the first field in the Grade Levels Taught table, type the first grade 
level in the school. Continue adding grade levels for all the grades in 
the school.

9. In the first field in the Promote Grade Level to field, type the 
appropriate grade. Each promote field corresponds to the Grade 
Levels Taught field above it. For example, if the grade in Grade Levels 
Taught is 06, the Promote Grade Level to would be 07. If two grade 
levels, such as K1 and K2, are promoted to grade 1, enter an 01 under 
these grades.

10. After you complete each field in the General tab, click Save to save all 
new entries.

11. Complete all appropriate fields for the Schedule, Enrollment, and Term 
Duration tabs. Remember to click Save after completing the fields in 
each tab.

Updating School Records

Because a school record affects so many atoms, you should exercise 
caution in making changes after a record is set up and users have begun 
entering data in application atoms.

! You can make changes in fields that do not affect the setup of other 
atoms. These fields include all the fields in the Basic tab and fields 
such as Meets on Saturday that do not determine the school type or 
attendance type.
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! You should not make changes in fields that affect the setup of other 
atoms. If you try to start an affected atom after making such a change, 
an error message may display and you can not start that atom.

1. Open the School atom and display the record you want.

2. In the first field to be changed, perform the appropriate changes. 
Continue making changes until you have made all the changes you 
want. If the fields are on another tab, click that tab to go there.

3. Click Save to save all new entries and add the school record to your 
list of schools.

4. Click OK to confirm that you want to save all changes.

5. Click Close to close the School atom.

Changing Data in the Sch # and Name Line

1. From the Basic tab in the School atom, display the school record you 
want.

2. Select the Change Sch # and Name option from the School menu and 
make the appropriate changes.

3. If you want to work in any fields below the Sch # and Name line, click 
those fields and make changes as needed.

4. Click Save to save all new changes, then click OK to confirm that you 
want to save changes.

5. Close the School atom.

Inactivating and Deleting School Records

You can work from the School atom to delete, inactivate, or activate school 
records using options on the Data menu. The Inactivate option on this 
menu changes to Activate when an inactive record displays:

! Inactivating a school changes a school record to inactive. Because 
inactive records are not locked or removed from the database, you can 
display, change, or reactivate them at any time. Inactive records are 
identified by parentheses around school names in the Title Bar of atom 
tabs.

! Deleting a school from the School atom permanently removes a 
school’s entire file from the database. Because deleting a school 
affects all records associated with that school, this is done only under 
special circumstances.
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Inactivating School Records

1. Open the School atom and display the record you want to inactivate.

2. Select the Inactivate School option from the Data menu.

3. Click Save to save the change. The system displays the school’s name 
in parentheses in the title bar of all School atom tabs to indicate that 
the school’s status is inactive.

4. Click OK to confirm that you want to save the change.

Reactivating Inactivated Records

1. Open the School atom and display the record you want to reactivate.

2. Select the Activate School option from the Data menu.

3. Click Save to save the change. The system removes the parentheses 
from the school’s name in all School atom tabs and its record is once 
again active.

4. Click OK to confirm that you want to save the change.

Deleting School Records

1. Open the School atom and display the record you want to delete.

2. Select Delete School from the Data menu. All data is cleared from the 
tab and the school’s record is permanently removed from the SASIxp 
educational software database.

3. Click OK to confirm the delete.

4. Click Close to close the School atom.

Basic Fields

Field Description

Sch # District-assigned school number. The system 
enters the next number automatically when 
you add a new school record to the SASIxp 
software database.

School Name School’s complete name that prints on 
reports.
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Alternate # Any other number being used for the school, 
such as a state-designated number.

Sch Abrv Abbreviated version of a school name.

Telephone Complete phone number for a school, 
including area code.

Address Street address portion of a school’s location.

SASIxp software accepts fractional 
addresses, such as 1055 ½ E. Main Street. 
To enter this fractional address, type 1055 
1/2 (including the slash). Decimal point 
entries are not valid.

City City in which a school is located.

St Two-character postal service abbreviation for 
the state in which a school is located.

Zip Code Five-digit postal service zip code for the 
school’s location. You can add a hyphen and 
four-digit extension.

Principal Name Name of the school’s principal.

Sch Fax Fax number for the school.

Att Phone Phone number of the school’s attendance 
officer.

Ext Any extension to the attendance officer’s 
phone number.

District ! If you are using District Integration, select 
the Centralized District Processing option 
from the pop-up list. This option must be 
selected before you can communicate 
with the Task Server at the district level.

! If you are not using the District Integration 
module, leave this field at its default 
setting of Local Processing.

Permit Number School’s mailing permit number.

Field Description
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General Tab

This tab of the School atom enables you to identify the grade levels taught 
at a school, promotion grade levels, beginning and ending periods, 
number of tracks, track type, attendance type, any telephone dialer used 
by the school, and more.

Active Year Enter the current year in this field to activate 
the screen colorization feature. Screens for 
the current year display as light blue. The 
next year displays in green, the previous year 
in pink.

Field Description
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Defining a School

General Fields

Field Description

Grade Levels Taught All the grade levels taught at a school; these 
display on the grade-level pop-up list used in 
various atoms. You can enter up to 20 grades 
in the grade-level table; each 2-character 
field has room for one grade. For example, 
you might enter 00 in the first table field for 
kindergarten and 01 in the second field for 
first grade.

Promote Grade Level To Grade level to which the grade levels in the 
Grade Levels Taught field are promoted. For 
example, if Grade Levels Taught are 07, 08, 
09, you enter 08 in the first field of this field 
(which is directly beneath the first field in the 
Grade Levels Taught field) to show that 7th 
grade is promoted to 8th grade. Enter 09 in 
the second field, and leave the third field 
blank, because 9th graders graduate and go 
to another school for the next grade.

Periods: Begin First period of the day at a school using 
schedules. Along with the entry in the End 
Period field, this defines the range of periods 
available. If you enter fewer than 14 periods, 
the SASIxp software assumes that 
attendance is taken every period. If you enter 
14 periods or more, a table for specifying the 
periods when attendance should be taken 
displays in the Other Options tab of the 
Attendance Setup atom. You can use either 
00 or 01 to indicate the first period.

Periods: End Last period of the day at a school using 
schedules. Along with the entry in the Beg 
Period field, this value defines the range of 
periods available. If you enter 00 in the Beg 
Period, entering 13 in the End Period field 
would indicate a range of 14 periods.



Using the School Atom

10   Copyright © 2004 Pearson School Systems

Tracks Number of tracks a school is using; you can 
define a maximum of nine. This field 
determines how many tracks are shown on 
the pop-up list of tracks available from the 
Attendance Calendar in the Attendance 
Setup atom.
Do not change values in this field once users 
begin entering data.

Password: Minimum 
Length

Minimum number of characters required for 
user passwords. These passwords are used 
for logging in and for unlocking the SASIxp 
desktop. The minimum entered displays in 
the User Password window in the User atom 
where passwords are defined.

Days to Expiration Number of days until the users must change 
their password.

Inactive Minutes To: 
Screenlock

Number of minutes until the lockout screen 
displays at workstations after keyboard 
activity stops. The lockout screen hides the 
SASIxp software desktop so that data cannot 
be viewed or changed by unauthorized users. 
You can also change passwords from this 
screen. To set the time interval, enter the 
number of minutes in the field. You can also 
set the lockout time in the User atom. If you 
specify a different interval than is specified in 
the User atom, the program uses the shorter 
of the two intervals. To unlock the screen, 
users must enter their password in the field 
provided.

Inactive Minutes To: 
Shutdown

Number of minutes until the SASIxp software 
is shut down at workstations after keyboard 
activity stops. For example, if you enter 120 
in this field, the program automatically shuts 
down two hours after the last keyboard 
activity. This feature ensures that all 
workstations exit from the SASIxp software at 
the end of the day, even if one or more users 
accidentally leave the program running.

Field Description
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Track Type If a track school, select the type of track 
system used. Select from a program-defined 
pop-up list with three choices:

! Traditional (no tracks)
! Alpha (A-I) for track systems using 

alphabetic indicators for tracks
! Numeric (1-9) track systems using 

numeric indicators for tracks

Attendance Type Type of attendance system a school uses: 
daily or period. The type you select 
determines whether the Daily Attendance or 
Period Attendance atom is active. It also 
determines whether Daily or Period is 
available in the Attendance Setup atom. 
Schools using a daily attendance system can 
activate half-day attendance options in that 
atom.

Telephone Dialer Type of auto dialer system a school uses (if 
any). Select from a program-defined pop-up 
list.

Print Locker Locker information that should be printed on 
locator cards. You can select an entry from a 
pop-up list with three choices:

! None
! Locker Number
! Number and Combination

Note: Information for locator cards comes 
from the Locker and Student atoms.

Use Combination Default locker combination to print on locator 
cards and class schedules. You can choose 
any of the five combinations defined in the 
Locker Atom.

Field Description
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Confirm:   Add  Change
Delete

Entries in the three confirm fields specify 
whether users should receive a confirmation 
message when they try to save additions, 
changes, or deletions. You can select entries 
from a program-defined pop-up list with the 
following choices:

! Always – causes a confirmation message 
to display with OK and Cancel buttons 
every time users click Save.

! Never – suppresses the confirmation 
message. Additions, changes, or 
deletions are saved as soon as Save is 
selected.

! User Pref. – causes check boxes for 
Always and Never to display in the User 
atom so that one can be selected for 
individual users instead of all users.

Using Photos Indicates whether a school is using student, 
teacher, or staff photos with SASIxp 
software. Photos display in atom pages and 
in the message center.

Allow 2 Students Per 
Locker

When selected, this check box indicates that 
two students can share one locker.

Field Description
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Residence Address 
Validation 

Choose the validation action you want taken 
from a pop-up list:

! Do Not Parse – SASIxp software does 
not validate the student’s address.

! Parse Only – SASIxp software checks for 
address data, but does not validate it.

! Validate – SASIxp software validates new 
student addresses against the Street File. 
If the student lives within the school 
enrollment area, the system completes 
various address-related fields in the 
Student atom automatically. If the student 
does not live within the school enrollment 
area, the system prompts users to enter 
an attendance permit code and date.

! Forbid Invalid – SASIxp software does 
not process students with invalid address 
data.

Restrict Students by 
Teacher

When selected, this school-wide checkbox 
restricts teachers from viewing other 
teacher's sections. You may also set up 
Teacher Filter on Sections in the User atom, 
for specific teachers.

This field is used by NCS ABACUSxp™.

Paperless Environment Select this option, to support a paperless 
environment for audit trail purposes.

Enable Central Address 
Validation

When selected, this checkbox allows 
addresses to be checked against the district 
file. If you have a school street file, it isn’t 
used if this checkbooks is selected. The 
District can distribute the central street file to 
all schools using District Integration, allowing 
the Street atom to be used to find addresses 
manually if needed.

Field Description
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Schedule Tab 

The Schedule tab of the School atom enables you to enter schedule-
related information for your school. The school type you select for a school 
determines how the SASIxp software uses the Teacher, Course, Sections, 
Schedule, and Attendance atoms when users are logged on to that school.
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Schedule Fields

Field Description

School Type The type that best describes your school. 
The school type determines the atoms 
SASIxp software uses when users perform 
various functions:

! Secondary – For a secondary school, 
SASIxp software works with the Sections, 
Course, and Schedule atoms as well as 
the Teacher atom. This school type is 
typically used by middle and high 
schools. For example, the program refers 
to the Sections atom when users display 
Class Attendance records. It looks for 
Teacher numbers in the Master Schedule 
(AMST) file in the Schedule atom when 
users sort Class Rosters and Attendance 
reports.

! Elementary, No Schedules – For this type 
of school, SASIxp software works 
primarily with the Teacher atom for 
student- and class-related functions. For 
example, the program refers to the 
Teacher atom when users display Class 
Attendance records. It uses teacher 
numbers for sorting purposes in Class 
Rosters and Attendance reports.

! Elementary, With Schedules – For this 
type of school, SASIxp software works 
with the Sections, Course, and Schedule 
atoms as well as the Teacher atom. For 
example, the program refers to the 
Sections atom when users display Class 
Attendance records. It looks for Teacher 
numbers in the Master Schedule (AMST) 
file in the Schedule atom when users sort 
Class Rosters and Attendance reports. 
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Gen. Section ID Specifies how you want the system to 
generate Section IDs.

! Manual – Enables users to enter section 
IDs. The program validates entries to 
prevent duplication.

! Period & Counter – Tells the program to 
automatically assign section IDs using 
the next available system-generated 
counter with period numbers in front.

! Counter – Tells the program to 
automatically assign section IDs using 
the next available system-generated 
counters.

! Course & Period – Tells the program to 
automatically assign section Ids using 
course and period numbers.

! Course & Manual – Tells the program to 
automatically assign the first portion of 
each section ID, using course numbers. 
Users can then complete the IDs with 
additional numbers as needed.

Term Type Identifies the school’s term structure. Set this 
field to the smallest term in your schedule.

! Year Schedule – Uses year-long classes.
! Semester Schedule – Uses semesters or 

two half-years.
! Trimester Schedule – Uses trimesters or 

three terms.
! Quarter Schedule – Uses quarters or four 

terms.
! Other Schedule – Uses some other 

method of term organization. 

Field Description
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Split Week Specifies whether a school allows split-week 
scheduling and the type.

! No Split Week Class – Reflects traditional 
scheduling or allows use of scheduling 
cycles and period rotation.

! Split Week, Same Period – Use of split-
week classes is allowed, but each split 
must be scheduled in the same period. 
The default is a scheduling cycle of 5 
days (or 6, if classes meet on Saturday).

! Split Week, Allow Different Period – Use 
of split-week classes is allowed and you 
can schedule splits in different periods. 
This option is useful where meeting times 
may vary throughout the schedule.

Full Class Specifies whether students can be added to 
full classes. Choose from the following 
options:

! Allow Add, No Warning – Enables users 
to add students to full classes without a 
warning.

! Allow Add, With Warning – Enables users 
to add students to full classes, but 
displays a warning message when an 
add exceeds the number of students 
allowed when using the Walk-in 
Scheduling, Classes, and Scheduling 
atoms.

! Don’t Allow Add – Restricts users from 
adding students to a full class.

Field Description
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Master Schedule Indicates whether users can make changes 
to the Master Schedule.

! Allow all changes – Enables users to 
make any changes to the Master 
Schedule.

! Allow removal and modification of empty 
sections – Enables users to remove or 
make changes to empty sections only.

! No changes allowed – Prohibits users 
from making any changes to the Master 
Schedule.

Classes Start Date Indicates the date you want the system to 
use as the start date for classes. The choices 
are:

! System date (default)
! Next valid calendar date

Course Length Indicates the maximum number of characters 
allowed for course IDs. You can specify 1 to 
14 characters.

Section ID Length Indicates the maximum number of characters 
allowed for class or section IDs. This number 
depends on what you selected in the Gen. 
Sections ID field.

Homeroom Period Identifies the Homeroom period. Use this 
feature for schools set up as Elementary with 
Schedules and using Daily Attendance. If 
they use scanning, the scan sheets print for 
the sections during this period.

Field Description
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Teacher Aide Course ID (up to 8 characters) used in the 
Scheduling and Grade Reporting atoms for 
students serving as teacher aides. If a 
student is an aide for Algebra, put the section 
number for the Algebra class they are an aide 
for in the student’s classes and tag the 
student as a TA in the Algebra section 
screen. After tagging the student, it displays 
on attendance scan sheets with the TA at the 
bottom of the sheet, grading has a sheet just 
for the TA and on the locator card it states 
that the student is a TA.

Period Rotation If your school uses period rotation (1st 
schedule period meets 1st bell period on one 
day, 2nd bell period another day and so forth), 
select the number of rotation days from the 
pop-up list. If you are also using scheduling 
cycles, this period rotation number must be 
divisible by the number of days in the 
scheduling cycle.

Scheduling Cycle If your school uses a scheduling cycle, select 
the number of days in the cycle from the pop-
up list. For example, if classes meet every 
other day, select a 2-day cycle. If classes 
meet every day, and you do not want to use 
scheduling cycles, select None. When you 
select a scheduling cycle, a small matrix 
displays with the number of days you 
selected for the cycle. Enter the identifier for 
the day of the week under each day number 
(for example, Day 1 = R, Day 2 = S, Day 3 = 
T, etc.) These identifiers are used by the 
Rotation Definition atom to set up period 
rotation schedules.

Change the value in this field before you 
change Period Rotation.

Cycle Days Matrix Enables you to name the days of your 
scheduling cycle with a 1-letter code, such as 
A or B.

Field Description
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Meet on Saturday When selected, this checkbox specifies that a 
school has Saturday classes. If you select 
this option, the program adds columns for 
Saturday to calendar screen in the 
Attendance Setup and Attendance atoms.

Allow Split Year-Long When selected, this checkbox indicates that 
a school allows split schedules for year-long 
classes.

Use Section Linking When selected, this checkbox indicates that 
grades and attendance information follows 
students who change between linked 
sections in mid-semester or mid-term. You 
create and add section links in the Classes 
atom.

To use section linking with Attendance, you 
must also select the Use Section Attendance 
checkbox on the Advanced tab of the 
Attendance Setup atom.

Field Description
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Enrollment Tab

The Enrollment tab of the School atom enables you to specify enrollment-
related information for your school. It’s also where you select the user 
codes and optional fields to include in the Enrollment atom.
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Enrollment Fields

Field Description

Effective Date Enables you to allow or disable the automatic 
update of effective dates.

! Allow Defaulting of Effective Dates – This 
option tells the program to automatically 
enter effective dates when changes are 
made in the Enrollment atom. The current 
date is used. In addition, this option tells 
the program to display the current date in 
the dialog box that comes up in the 
Student atom when you make entries or 
changes that affect enrollment.

! Disable Defaulting of Effective Dates – 
This option tells the program that users 
must enter effective dates when changes 
are made in the Enrollment atom. In 
addition, this option tells the program to 
display a blank effective date field in the 
dialog box that comes up in the Student 
atom when you make entries or changes 
that affect enrollment. 

Default Enter Code
(ENT table)

Default enter code that is automatically 
entered when users enroll students in the 
Enrollment atom.
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Leave Date Day that qualifies as the leave date when 
students leave.

! Leave date is the first day of non-
enrollment – Counts the leave date as the 
first day a student is not enrolled at a 
school. (For example, if leave date is 
8/24, no attendance is counted for that 
day and 8/24 is a non-enrollment day.)

! Leave date is the last day of enrollment – 
Counts the leave date as the last day a 
student is enrolled at a school. (For 
example, if leave date is 8/24, attendance 
is counted for 8/24 and 8/25 is the first 
day of non-enrollment.)

Note: Districts using District Integration must 
use this option.

Default Leave Code
(LVE table)

Default leave code that is automatically 
entered when users inactivate students in the 
Enrollment atom.

No Shows Enables you to allow or disable the No Show 
button in the Enrollment atom.

! Allow No Shows in Enrollment – Causes 
the No Show button to display in the 
Enrollment atom. You can inactivate a 
student who enrolled but never showed 
up without losing their enrollment 
information.

! Disable No Shows – Prevents the No 
Show button from displaying in the 
Enrollment atom.

Graduation Code Leave code used to indicate that a student 
has graduated from your school. When you 
select a leave code in this field and there is a 
date in the Grad Date field for this student, 
the word “Graduated” prints on the student’s 
transcripts.

Field Description
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Term Duration Tab

The Term Duration tab of the School atom enables you to enter term start 
and end dates for each track. The SASIxp software uses this data when 
creating scan sheets using the Attendance Scanning and Scheduling 
atoms.

Use Enrollment 
Validation

When selected, this checkbooks activates 
enrollment validation.

Service Program Exit 
Code

Code used as the default service program 
exit reason for the year-end process.

Student Data Changes 
Affecting Enrollment

Select these checkboxes to include the 
indicated fields on the Enrollment atom. The 
fields you may include are:

! Track
! Grade
! Inst Set (instructional setting)
! Teacher
! User Codes 1-9
! User Num 1-5

Be sure to include attendance-related User 
Codes in the Enrollment atom. These codes 
must be tracked for attendance and 
apportionment purposes. All user codes and 
user numbers are shown in the Student 
atom. However, if you want to specify some 
user codes and user numbers as enrollment-
related (and include them in the Enrollment 
atom), click these checkboxes.

Field Description
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Information on this tab must match the term type field on the Schedule 
screen of the School atom.



Using the School Atom

26   Copyright © 2004 Pearson School Systems

Term Duration Fields

Field Description

Track Tracks for which you need to 
define terms; select from the pop-
up list.

The Track box displays only if you 
selected a track type in the 
General tab and entered a number 
in the Tracks field. The number of 
tracks shown on the pop-up list is 
determined by that number.

Title Title assigned to each term; for 
example, Semester 1 or 
Trimester 2.

Starting Starting date for each term. Do not 
overlap dates.

Ending Ending date for each term. Do not 
overlap dates.

Columns 1-6 Abbreviations for the titles of all the 
terms that fall within each term. 
For example, if you are working in 
the row for the first quarter, you 
might select YR in column 1, S1 in 
column 2, and Q1 in column 3. You 
can select abbreviations from the 
program-defined pop-up list 
available from each field in these 
columns.
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Localization Tab

The Localization tab of the School atom enables you to select the state or 
country where your school is located. This setting causes the program to 
change underlying codes to match the reporting requirements of your state 
or country.
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Localization Fields

Field Description

Localization This flag sets SASIxp software to enable the 
reporting that is required by your state. Select 
from the list of states and international 
countries or regions.

Note: When the localization changes, the 
tables and definitions for the user code 
fields are changed. Any information 
entered in user code fields before you 
changed the localization code is lost. If 
you change to the wrong localization 
code by mistake, you can clear the 
changes by setting the localization 
code back to blank, saving the 
settings, then exiting and restarting 
SASIxp software.

District Number Number assigned to the District by the state. 
This field does not display for all states.

District Type Type of district. This field is used for state 
extracts; the choices displayed depend on 
the state selected in the Localization field. 
This field does not display for all states.

Module Localization The localization code for each SASIxp 
module shown:

! Attendance
! Grades
! Transcript
! Scheduling
! Special Education

You can use a different localization for each 
module. Settings selected override the 
setting in the Localization field at the top of 
the screen.
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International Options Fields in the Localization Tab

These options control how dates and phone numbers are displayed on 
SASIxp screens and reports. You can also specify the fields you want to 
print for address lines 1 and 2 on many reports.

Field Description

Date Format The date format you want to use. Choices 
include American — mmddyy or International 
— ddmmyy.

Date Separator 
Character

Separator character you want to use to 
separate the month, day, and year portions of 
the date.

Phone Format (Digit 
Grouping)

How to group phone digits. For example, the 
phone number 714-888-6001 uses a phone 
format of 334 (three digits in the first group, 
three in the second group, and four in the last 
group).

Phone Separator
Character

Separator character you want to use to 
separate the digits in the phone number.

Time Format Time format you want to use. Choices 
include American — 07:45 p.m. or 
International — 19:45.

Display Country Whether the Country field is displayed in the 
Student and Parent/Guardian atoms.

Display Province Whether the Province field is displayed in the 
Student and Parent/Guardian atoms.

Display Passport 
Number

Whether the Passport Number field is 
displayed in the Student atom.

Address Line 1 The fields you want to display for the first 
address line to print on labels and student 
directories. You can choose up to three 
fields.

Address Line 2 The fields you want to display for the second 
address line to print on labels and student 
directories. You can choose up to three 
fields.
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Work from the Tables Definition atom (in the System Setup folder) to 
create most of the pop-up lists that are available in various fields in the 
SASIxp atoms. Pop-up lists are identified here as tables.

Some tables, such as the pop-up list for Gender, are program-supplied 
and cannot be changed; some tables, such as the pop-up list for Ethnic 
Code, contain program-supplied values that you can add to or delete; and 
some tables, such as the pop-up list for Employee Code, are user-created.

Finally, some pop-up lists are defined in other atoms. For example, the list 
of absence reasons is defined in the Attendance Setup atom.

The Table Definition atom contains two tabs:

! Table List
! Table Definition
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Table List Tab

The Table List tab contains two matrixes. The left matrix is a list of the 
tables used as pop-up lists in other SASIxp atoms. Select a table by 
clicking its name. The codes for the values contained in a selected table 
are listed in the matrix on the right. You can add and delete value codes for 
the selected table from this matrix.

Adding Values to a Table

You can add values to all tables that are not entirely program-defined or 
have a security level from 2-4, or that have not been defined in another 
atom. To determine which tables allow for user additions, watch the Add 
button under the right matrix of the Table List tab as you click tables in the 
left matrix:

! If you can add to a table, the Add button is available and shown in 
white.

! If you cannot add to a table, the Add button is unavailable and 
dimmed.

! Each table used as a pop-up list can contain as many values as 
needed. Where appropriate, you might want to add one code to serve 
as None. For this code, leave the Code field in the right matrix blank 
and only fill in the Description field.
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Preserving Table Values During the Merge Tables Process

Tables with a security level of 0 (zero) are controlled by the SASIxp 
software and are automatically updated during the Merge Tables process. 
To make permanent changes to these tables and prevent the SASIxp 
software from overwriting your changes, do the following (detailed steps 
follow):

! Change the security level of the table from 0 to 3.
! Modify the table as desired, and then change the security level back 

to 0.
! Create the SKIPTBLS.DAT file. This file tells the SASIxp software to 

skip the designated files during the Merge Tables process.

To modify tables with a security level of zero

1. In the Utilities folder, double-click the Query atom.

2. Run a query to change the security of a table type from 0 (zero) to 3. 
You must be a security officer and have mass update rights to run this 
query. For example, to change the Gender table, type the following 
query and click Do.

Change ATBD  Security = 3 IF  TableType = GEN

3. Click OK to close the warning message, and then close the Query 
atom.

4. In the System Setup folder, double-click the Tables Definition atom.

5. Scroll to the table you want to modify and click to select it.  

6. Click Add and type new codes and descriptions as desired. To change 
or add Alt Code values, click Show Alternate Codes on the Tables 
menu on the SASIxp menu bar.

7. Click Save.

8. Open the Query atom and change the security level of the table back 
to 0 (zero) with the following query:

Change ATBD Security = 0 IF TableType = GEN (where GEN is the 
three-letter table code)
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To create the SKIPTBLS.DAT file

1. In a word processor, create a new document and type the following 
entry: 

SKIP=GEN (where GEN is the three-letter table code for the table you 
want to preserve during the Merge Tables process)

2. Type additional lines using the same format as needed.

3. Name the document SKIPTBLS.DAT and save it to your SASIxp folder 
(the same folder that contains the SASIxp.exe file).

4. When you run the Merge Tables process (in the File Management 
folder), the following message appears to identify which tables are 
skipped.
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Selecting a Group of Tables

You can either display and work on the tables that apply to a specific folder 
in the SASIxp software, or you can display all of the tables at once.

1. In the Group field, select the folder whose tables you want to work on. 
The tables that belong to that group displays. All other tables are 
hidden.

2. To redisplay all tables in the system, click the Group field and select All 
Tables.

Table List Fields

Field Description

Group This pop-up list enables you to display and 
work on only the tables that apply to a 
specific folder in the SASIxp software.

Current Table Box Positioned above the right matrix, this box 
displays the description of the table you are 
currently working with and the maximum 
code length.

Left Matrix Each row is defined with a line number. The 
Type column contains the 3-letter 
abbreviation for each table in the list. The 
Table Description column contains a 
description for each table.

Right Matrix Each row is identified with a line number. The 
Code column contains codes for all the 
values in the table selected in the left matrix. 
The Description column contains a 
description of each code.

Add Button Enables you add codes to the table you are 
working with in the right matrix.

Delete Button Enables you delete codes from the table you 
are working with in the right matrix.
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Table Definition Tab

The Table Definition tab of the Tables atom enables you to add and delete 
tables, and modify table headings and descriptions.

Table Definition Fields

Field Description

Group This pop-up list enables you to display and 
work on only the tables that apply to a 
specific folder in the SASIxp software.

Ln The line number for each row.

Type The 3-letter abbreviation for each table.

Table Description A description for each table.

Len Maximum number of characters allowed for 
codes in each table.

D Len Maximum number of characters allowed for 
code descriptions in each table.
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Adding a Value Code

1. Open the Tables Definition atom.

2. In the left matrix of the Table List tab, select a table by clicking on its 
name. The values contained in the selected table displays in the right 
matrix, and the table’s name and maximum number of characters for 
codes in the table displays in the current heading field.

3. Click Add if it’s dimmed. The system adds a new line to the end of the 
list in the right matrix and the cursor is positioned in the Code field.

4. Type a value code in the Code field, referring to the current heading 
box above the matrix for the maximum number of characters allowed.

5. In the Description field, type a description for the code.

6. Click Save, then OK to save the new value code and description. You’ll 
need to do this before you can add another code.

7. Click Close.

Modifying Value Codes and Definitions

1. Open the Tables Definition atom.

2. In the left matrix of the Table List tab, select the table you want to 
modify. The value codes contained in the selected table display in the 
right matrix.

Secu Security level for each table that determines 
whether users can make changes to codes in 
each table and the types of changes they can 
make.

Code Heading The heading used to label the field for each 
table in atom tabs. You can work from this 
column to change headings.

Description Heading The description that displays in the message 
center when the field for a table is pointed to 
in atom tabs. You can work from this column 
to change descriptions.

Type Num Set to 0.

Field Description
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3. Click a field in the right matrix and make the desired change(s). Check 
the current heading box above the matrix for the maximum number of 
characters allowed for the code.

4. Click any additional fields you want to work with and make changes as 
needed.

5. Click Save, then OK to save your changes, or click Undo to restore the 
previous entries.

Deleting a Value

1. Open the Tables Definition atom and display the Table List tab.

2. In the left matrix of the Table List tab, select the table you want to 
delete a value from. The values contained in the selected table display 
in the right matrix.

3. Click the line number for the value you want to delete to highlight and 
select it. The Delete button below the list activates.

4. Click Delete. The system deletes the value code and its description the 
matrix.

5. Click Save to permanently delete the value.

6. Click OK to confirm or click Undo to restore previous data.
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Work with the User atom (in the System Setup folder) to set up User 
records for each staff member who uses the SASIxp software.

The folders and atoms you assign to a user (and/or user class) in the SASI 
Modules Setup atom are available in the SASI Modules Globe on the 
user’s desktop.

If you include the User atom in SASI Modules for users who are not 
designated are Security Officers, they are able to access their own user 
record from any school they’re logged on to and select their own 
preferences. However, users cannot access records for other users. In 
fact, the Forward/Back arrows for scrolling through records that display at 
the top of their User form and the Next and Previous options are not active 
on the Data menu.

The User atom contains three tabs:

! Options
! ABACUS
! SQL

Options on the User Menu

Field Description

Change Password This option displays the User Password 
window so that you can change a user 
password (you can also click Change 
Password button in the User atom).

Attach User Photo This option enables you to attach a photo to a 
user record. The user’s photo displays in the 
photo box in the User atom and in the Mini 
Pic box in the message center whenever the 
user’s record displays.
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Setting Up a User Record

Setting up a user record consists of two parts, which can be performed at 
the same time:

1. Add a user and identify his or her user class (if any), the year and 
school he or she is logged on to, and his or her discipline security level. 
This information is entered in the top two lines of the User atom. 
Mandatory basic data consists of User ID and User Name.

2. Specify user preferences. These determine how a number of program 
features work.

Adding a User Record

1. Open the User atom. 

2. Select Add User from the Data menu.

3. In the User ID field, type the User ID that is used to log in to the 
SASIxp educational software. This is unique for each user; if the ID 
you enter is a duplicate of one already in use, the system displays an 
error message.

4. In the User Name field, type the user’s first and last name.

5. If the user belongs to a certain user class, use the pop-up list to select 
a school-defined list of user classes in the User Class field.

6. In the Year field, type the last two digits of the school year that the user 
is logged on to automatically. The year is designated by the first two 
digits, for example 98-99 year is designated by 98.

7. Fill in the remaining fields on the form.

8. Click Change Password. The User Password window displays.

9. In the Enter your new password field, type a password for the user; 
dots instead of letters display as you type.

Change ID, Name, Class This option unlocks the fields in the top line of 
the User atom so that you can make changes 
to user’s ID, name, or user class. Normally, 
this line is locked to prevent accidental 
change.

Field Description



Copyright © 2004 Pearson School Systems  41

Using the User Atom

10. In the Enter your new password again field, type the password again, 
exactly as before; dots display as you type. This action activates the 
Change button. If the password is less than the minimum length 
defined in the General tab of the School atom, the Change button does 
not activate.

11. Click Change to record the new password, close the User Password 
window and return to the User atom.

12. If the user is an ABACUSxp user, click the ABACUS tab, and select the 
data set you want for this user. Click Save to save your entries.

13. If this user also uses the ODBC feature, click the ODBC tab and type 
the user’s SQL user ID and password. Click Save to save your entries.

14. Click Save to save all new entries, including the password; this adds 
the user to the SASIxp educational software database.

15. Click OK to confirm the addition.

Updating a User Record

1. Open the User atom and display the record you want.

2. In the first field to be changed, make the appropriate change.

Click any additional tabs or fields you want to work in and make 
changes as needed.

3. Click Save to save all new entries (click Undo to revert to previous 
entries in all fields).

4. Click OK to confirm that you want to save changes.

Changing Data in the User ID, Name Class Line

1. From the User atom, display the record you want.

2. Select the Change ID, Name, Class option from the User menu.

3. Click in the first field to be changed and make the appropriate 
changes.

4. If you want to make changes in any fields below the ID, Name, Class 
line, click in the those fields and enter data there.

5. Click Save to save all new entries (click Undo to revert to previous 
entries in all fields).

6. Click OK to confirm that you want to save changes.
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Entering or Changing a User Password

1. From the User atom, select the record you want.

2. Select the Change Password option from the User menu.

3. In the Enter your new password field, type a new password for the 
user. (The cursor skips over the Enter your new password field when 
you log in as a Security Officer.) Passwords can be a duplicate of a 
password being used by another user or it can be unique to this user.

4. In the Enter your new password again field, type the password again, 
exactly as before. This activates the Change button. However, if the 
password has fewer than the minimum length defined in the General 
tab of the School atom, the Change button is not activated.

5. Click Change to record the new password, close the User Password 
window, and return to the User atom. (Click Cancel to revert to the 
previous password and return to the User atom.)

6. Click Save in the User atom to save the new password (if you click 
Undo, the previous password is reinstated).

7. Click OK to confirm that you want to save changes.

Inactivating a User Record

1. Open the User atom and display the record you want to inactivate.

2. Select Inactivate User from the Data menu.

3. Click Save to save the change; parentheses display around the user’s 
name in the title bar of the User atom to indicate that the user’s status 
is inactive. (Click Undo to keep the user active.)

4. Click OK to confirm that you want to save changes.

Reactivating an Inactivated Record

1. Open the User atom and display the record you want to reactivate.

2. Select Activate User from the Data menu.

3. Click Save to save the change; parentheses are removed from the 
user’s name in the User atom and their record is once again active. 
(Click Undo to leave the user record inactive).

4. Click OK to confirm that you want to save changes.
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Deleting a User Record

1. Open the User atom and display the record you want.

2. Select Delete User from the Data menu. All data for this user is cleared 
from the form and removed from the database.

3. Click OK to confirm that you want to save changes.

Setting Up a User Class

The procedure for setting up a user class is similar to that for setting up a 
user record, except that you do not make a selection in the User Class 
field and you do select the check box next to User Record is a User Class.

Immediately after you add a user class, you can select that class for all 
users who belong to it. When you assign folders and atoms to users in the 
SASI Modules Setup atom, you can to do this on the basis of user class.

Adding a User Class

1. Open the User atom.

2. Select Add User from the Data menu.

3. In the User ID field, enter an ID (Attendance, Counselor for example) 
for the user class. This displays on the pop-up list available in the User 
Class field when the record is saved.

4. In the User Name field, type a name for the class.

This serves as a description for the ID. For example, if you add an 
attendance user class, you might use ATTENDANCE as the ID and 
Attendance Users as the name.

5. Click the check box next to User Record is a User Class.

6. Fill in any other fields you want to set up for the user class.

7. Click Save to save all new entries, including the password; this also 
adds the user to the SASIxp educational software database.

8. Click OK to confirm the addition.
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User Fields

The top lines of each screen enables you to enter the basic information 
needed to add a user and identify the school the user should log in to.

Field Description

User ID ID the user enters to log in to the SASIxp 
software. This is unique for each user. This is 
a required field.

User Name User’s first and last name. This is a required 
field.

User Class User’s class, if any. If you set up folders and 
atoms according to user class, the 
folder/atom setup for any class selected is 
available when the user logs in.

The down arrow displays a list of school-
defined choices that can include classes 
such as Nurse or Attendance, a default user 
class such as SASICLASS, or None. The list 
of user classes is created by adding a user 
record for each class and selecting the User 
Record is a User Class checkbox for that 
record.
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Options Tab
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Options Fields

Field Description

Year Specifies the two-digit school year a user is 
automatically logged on to. This determines 
which records are available. Users can only 
access the data for one school year at a time. 
If the Change School/Year atom is included 
in the user’s setup, he or she can use that 
atom to select a different year while working 
with the program. The 97-98 school year 
displays as 97; 98-99 year as 98, and so on.

School Specifies the 3-digit number of the school a 
user is logged on to automatically. If the 
Change School/Year atom is included in the 
user’s setup, he or she can use that atom to 
select a different school while working with 
the SASIxp educational software. Any 
change is reflected here.

Image Input Device Specifies the type of input device available to 
attach photos to the SASIxp educational 
software records. The program-defined pop-
up list contains four choices: Video Camera, 
Disk File, Photo CD, and Scanner. For users 
with an AV series Macintosh, you can use 
Video Camera. This selection determines 
how the Attach Photo option (on menus in the 
Student, Teacher, User and Staff Info atoms) 
works for each user.

To activate these options, you also need to 
select the Using Photos option in the School 
atom.

Tch # If the user being set up is a teacher, select 
the teacher number from the pop-up list in 
this field. The pop-up list displays the 
teachers in the Teacher file This field must be 
filled in if the district is using the Classroom 
module.
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Find Field The name of the field that is highlighted 
automatically when you perform a Find. 
Options are Student Name or Student ID.

Dis Sec Lvl User’s discipline security level. This setting 
determines access to information on student 
discipline infractions in the Discipline atom 
and to discipline codes in the Discipline 
Codes atom. The higher a user’s security 
level, the greater their access to discipline 
data and the wider range of discipline codes 
they can view or modify.

For example, each discipline code is 
assigned a security level from 0 to 9 (in the 
Discipline Codes atom). A user with a 
security level of 9 can see and modify all 
discipline infractions in Discipline records. A 
user with a security level of 6 can see and 
modify only infractions with a security level of 
6 or lower.

Issue Confirmation on 
Add

Specifies whether a confirmation message 
should display whenever records are added 
in atoms. This field only displays in the User 
form if the User Pref. Option is selected for 
Confirm Add in the General tab of the School 
atom.

Issue Confirmation on 
Change

When selected, this check box specifies that 
a confirmation message should display 
whenever changes are made to records in 
atoms. This field displays in the User form 
only if the User Pref. Option is selected for 
Confirm Change in the General tab of the 
School atom.

Issue Confirmation on 
Delete

Specifies whether a confirmation message 
should display whenever records are deleted 
from atoms. This field only displays in the 
User form if User Pref. is selected for Confirm 
Delete in the General tab of the School atom.

Field Description
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Minutes Before Screen 
Locked

How many minutes of inactivity before the 
lockout screen displays. The lockout screen 
hides the SASIxp software desktop for 
privacy, and prevents unauthorized use by 
requiring a password to continue.

To set the time, enter the number of minutes. 
The lockout time can also be set in the 
School atom. The program uses the shorter 
of the two intervals.

Screen Lock Quit Option Determines whether or not you can quit from 
the SASIxp software lockout screen. Options 
enable you to quit and save, quit without 
saving, or you may set this field to prevent 
anyone from being able to quit from the 
lockout screen. This field affects only what 
happens when quitting and exiting the 
SASIxp software from the lockout screen.

If you are using a screen saver, make sure 
the number of minutes set for the saver is 
different from the number of minutes set in 
the Minutes before Screen Locked field.

Show Item Boxes Specifies whether gray outlines should 
display around all data fields in atom forms. 
These make it easier to see where each field 
begins and ends. Users can select this option 
from the Data menu for individual tabs.

Show Control Buttons Specifies whether control buttons are shown 
at the bottom of all atom forms. Control 
buttons consist of three buttons in a row: two 
larger versions of the Forward/ Back Arrows 
found at the top of most screens, and a 
magnifying glass-shaped button that 
activates the Find mode.

Users can select this option from the Data 
menu for individual screens.

Field Description
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Show Student Photos Specifies whether student photos attached to 
records should automatically display in photo 
boxes in atom tabs and in the Mini Pic box in 
the message center.

Show Data Exists in 
Enrollment

When selected, this check box specifies that 
dots automatically displays beside Fast 
Access atoms to identify the ones that 
contain data. Users can turn this option on 
and off using the Show Student Data option 
on the Enrollment menu.

Allow Multiple Logins Specifies whether this user can be logged on 
to the SASIxp educational software more 
than one time.

Desktop picture Select the picture you want to display on your 
desktop. Pictures are centered in the 
desktop. Large pictures are scaled to fit. This 
feature is available after you have set up your 
SASIXP.INI file to point to a directory 
containing pictures. Choices are:

! Any one of the pictures shown in the pop-
up list. Pictures must be in the PICT or 
JPEG format.

! Random Desktop Picture – a different 
picture is selected at random each time 
you log in to the SASIxp educational 
software.

! No Desktop Picture – no desktop picture 
displays.

Field Description
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User Record is a User 
Class

When selected, this check box indicates that 
the current record establishes a class of 
users. A blank box means that the record 
belongs to an individual user instead. When 
you save the record for a user class, 
whatever you enter in the User ID field 
displays in the pop-up list for the User Class 
field. You can then select that class for users 
as you create User records.

Any folder/atom setup defined for a user 
class is available for all users identified as 
belonging to it.

User is a Security Officer When selected, this check box indicates that 
the user is a Security Officer. Users with this 
status have global-level security rights and 
can perform setup, assign folders and atoms, 
arrange desktops, create filter atoms and 
toolbars, and access records for all users. 
Security Officer status is noted in the status 
bar that spans the top of the message center.

Open First Editable Field When selected, this check box specifies that 
the first user input field is selected 
automatically when a record displays. A 
selected field is either highlighted, or contains 
a flashing cursor.

Remember Last Entity When selected, this checkbox specifies that 
each newly opened atom automatically 
displays the record for the entity (student, 
teacher, or course) shown in the last atom. 
This enables users to continue working with 
the same entity without having to find it each 
time they start an atom.

Allow Student Delete Specifies whether this user will be allowed to 
delete students on the Enrollment atom. This 
field displays in the User screen only if the 
User Pref. option is selected in the 
Enrollment tab on the School atom.

Field Description
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ABACUS Tab

Change Password 
Button

Displays the User Password window where 
you can assign and change user passwords. 
The minimum number of characters required 
for a password is defined in the General tab 
of the School atom.

When you add a new user, the user ID 
automatically becomes the password. The 
password can be changed later, either by a 
Security Officer, or by the user via the User 
atom, the Login atom, the Login Screen, or 
the Lockout Screen.

Field Description
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Abacus Fields

SQL Tab

Setting Up a SQL Database User

If you use a SQL database for the SASIxp educational software, you must 
perform the following procedure to set up users in the SQL database. The 
SQL information is associated with the user's SASIxp User ID and User 

Field Description

Data Set Select the data set from the pop-up window if 
this user also uses data from the ABACUSxp 
application.

Teacher Filter on 
Sections

Choose from a pop-up list of options whether 
to use the teacher filter on sections. The 
options are:

! Use school default
! Use teacher filter
! Don’t use teacher filter
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Name, and is automatically passed to the SQL database login routine 
when the user logs in to the SASIxp educational software (this data are 
stored in the AUSR table).

You can choose to manually enter a SQL User ID (for example, if the user 
is already set up in the ODBC Database Security Manager) or use the 
Create SQL User button to automatically generate a SQL user ID and a 
randomly-generated password.

You must have full administrator privileges in the SQL database to create 
users. You must be a Security Officer in the SASIxp educational software 
to set up, view, or modify SQL IDs and passwords.

Adding a SQL User Record

1. Open the User Atom, and display the record for the user you want to 
set up in the SQL database.

2. Select the SQL tab.

3. Do one of the following:

! If the user does not have an existing SQL user ID, click Create 
SQL User. The system creates a SQL user ID that is a 
concatenation of the SASIxp user name and an optional prefix 
and/or suffix (you can set up the prefix or suffix you want to use in 
the rdbms.ini file). The SASIxp educational software creates the 
user in the SQL database, generates a random SQL password, 
and then displays a completion message. Click OK to continue.

! If the user does have an existing SQL user ID or if you want to 
manually assign an ID, enter it in the SQL User ID field, then click 
Save. Next, click Change SQL Password. In the SQL Password 
dialog box, enter the password for the user (or click Generate 
Password to automatically create a random password). Click 
Save to save the password and return to the User form.

4. Verify that the system created a valid SQL user ID and password by 
clicking Verify SQL Connection. If everything is operational, the 
SASIxp educational software will display the message: Connection 
Successful. Click OK. 

5. Click Close to close the User Atom.

If you do not see the Connection Successful message, or if the user has 
trouble logging in to the SASIxp educational software, refer to 
Implementing SASIxp with Microsoft SQL Server 7.0 for information on 
creating SQL users.
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SQL Field

Field Description

SQL User ID Type the SQL user ID and password for this 
user if you are using ODBC with the SASIxp 
educational software in your school.



Copyright © 2004 Pearson School Systems  55

Using the SASI Module Setup Atom

After you add User records, you can now assign folders and atoms to each 
user or user class using the SASI Modules Setup atom (in the System 
Setup folder). This atom enables you to tailor users’ SASI modules to their 
description. You do not need to give all users access to all atoms.

All users’ SASI modules are stored inside the SASI Modules Globe on 
their SASIxp desktops. SASI Modules refers to the folders and atoms 
assigned to individual users. SASIxp Modules also refers to the entire 
collection of folders and atoms a school is licensed to use.

You can also use the SASI Modules Setup atom to add folders and atoms 
to a user’s SASI Modules or remove them from it.

SASI Modules Setup Atom

The SASI Modules Setup atom consists of a matrix and a list of update 
options. The setup matrix enables you to assign folders and atoms to each 
user. It contains rows for all the SASIxp folders and atoms in SASI 
Modules and columns for all users with records in the User atom.
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To assign folders and atoms to users, select Yes, No, or blank access 
settings from the list that pops up when you click fields in the Public, User 
Class, and User columns.

Creating and Updating SASI Modules

The most efficient way to create or update SASI modules is to assign 
access to folders and atoms first to the public, second to user classes, and 
last to individual users, those who belong to a user class as well as those 
who do not. This way, you only need to assign access to user classes or 
individual users if it differs from the access assigned to the Public, 
because:

! Access to a folder or atom defaults to what’s entered in the Public 
column if the User Class and User columns for a user are blank.

! Access is based on what is entered in any User Class column for a 
user if their User column is blank.

! Access is based on what is entered in the User column for a user, no 
matter what is entered in the Public column or any User Class column 
for that user.

Guidelines for Assigning Folders and Atoms

! If you want a user, a user class, or the public to have access to all 
atoms in a folder, select Yes for that folder in the appropriate column.
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! If you do not want a user, user class, or the public to have access to 
any of the atoms in a folder, select No for that folder in the appropriate 
column.

! If you want a user, a user class, or the public to have access to a few 
(but not all) of the atoms in a folder, select No for that folder in the 
appropriate column. Then select Yes for each atom users should have 
access to. If all columns are blank for an atom, each user’s access to 
that atom is determined by his or her access to the folder that contains 
the atom.

! If you want a user, a user class, or the public to have access to most 
(but not all) of the atoms in a folder, select Yes for that folder in the 
appropriate user column. Then select No for each atom users should 
not have access to. If all columns are left blank for an atom, each 
user’s access to that atom is determined by his or her access to the 
folder that contains the atom.

! If you plan to select the same access setting for all the atoms in a 
folder, you only need to display the row for that folder.

! If you plan to select different access settings for different atoms in a 
folder, double-click the name of that folder to display rows for all the 
atoms it contains, or select the Expand All Folders option from the 
Setup menu to display rows for the atoms in all folders.

Assigning Folders and Atoms to Users

1. Open the SASI Modules Setup atom.

2. Click the name of the first folder to highlight its row.

3. Click the Public field for the selected folder. When the list of access 
settings displays, use the program-defined pop-up list to select the 
default for that folder.

4. If you want to assign a different access setting to a user class, click the 
field for the selected folder in the appropriate User Class column. 
When the list of access rights displays, select the option you want to 
use. The right you enter here applies to all users in that class, unless 
you enter different rights for individual users.

5. If you want to assign a different access setting to individual users, click 
field for the selected folder in the appropriate User column (under 
either No User Class or User Class headings). When the list of access 
rights displays, select the option you want. If a user’s column is 
“folded” under a User Class heading, you can display it by double-
clicking the column heading for the user class or selecting the Expand 
All Classes option from the Setup menu.
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6. Repeat Steps 2 through 5 for each folder and atom you want to assign 
access to.

7. Make sure you select Update SASI Modules in the pop-up list of 
update options shown below the matrix. If it’s not selected, click the 
down arrow there to display the pop-up list of update options, and 
select the option you want.

8. Click Save to save all new entries.

9. Click OK to confirm saving new entries.

10. Click Close.

Duplicating an Entry Using the Quick Change Technique:

1. Select an access right in one field as you normally would.

2. For each subsequent field, hold down the Option key (Macintosh) or 
the Alt key and left mouse button or right mouse button (Windows) and 
click the field. The access right selected last displays in each field. You 
can work each consecutive row or column, or you can randomly jump 
from field to field.

Duplicating an Entire Column

1. To select a column of settings to copy from one user to another, click 
(and hold) on the title field. This highlights the entire column.

2. Drag and drop the highlighted column to the destination column.

Expanding and Folding Rows and Columns

When you open the SASI Modules Setup atom, rows for atoms and 
columns for users assigned to a user class are hidden from view. You can 
“expand” these rows and columns to display them, then “fold” them again 
to save room in the setup matrix.

Techniques for Expanding and Folding Rows

! To expand or fold the rows for atoms contained in one folder, double-
click the name of that folder. The atom rows display or disappear under 
the row for the selected folder.

! To expand the atom rows for all folders, select the Expand All Folders 
option from the Setup menu.
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! To fold the atom rows for all folders, select the Fold All Folders option 
from the Setup menu. Only rows for folders are then displayed.

Techniques for Expanding and Folding Columns

! To expand or fold the user sub-columns for one user class, double-
click the column heading for that User Class column.

! To expand the user sub-columns for all user classes, select the 
Expand All Classes option from the Setup menu.

! To fold the user sub-columns for all user classes, select the Fold All 
Classes option from the Setup menu. Only columns for user classes 
and users not assigned a user class are displayed.

Setting Up Desktops

Once you assign folders and atoms, you can:

! Log in as a user or user class.
! Copy folders and atoms from the SASI Modules Globe to the 

workspace.
! Arrange them however you want.

You can also lock the folders and atoms in place in the workspace. If you 
do not copy folders and atoms to the workspace, or if you do copy them 
but do not lock them in place, users can arrange the workspace 
themselves.

As part of the desktop setup, you can:

! Create toolbars for each user or class that are tailored to their specific 
job responsibilities.

! Create data filters for each user/user class and lock them into the 
System Filter folder to permanently activate them for that user/class. 
Data filters work in the background to screen data so that only data 
that meets filter criteria is available.

Setting Up User Desktops

1. Open the User atom and display the record for each user/user class for 
which you want to set up a desktop.

2. Select the check box next to User is a Security Officer to temporarily 
assign Security Officer status to the user.
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3. Log in using the user ID and password for the first user or user class 
for which you want to set up a desktop. A clean desktop displays, with 
only the SASI Modules Globe, System Filter Folder, In Folder, and 
Eraser.

4. Open the SASI Modules Globe. All the SASIxp educational software 
folders and atoms assigned to the current user or user class display.

5. Copy each folder you want from the SASI Modules Globe to the 
workspace.

6. In the SASI Modules Globe, open each folder you want to copy atoms 
from.

7. Copy each atom you want to the workspace or to the appropriate 
folder.

8. Arrange folders and atoms in the workspace in any way you want.

9. To lock a folder/atom in place so that it cannot be moved around the 
workspace, click that folder/atom to highlight it and select the Atom 
Info option from the File menu. Click the check box next to Locked to 
lock the folder/atom. If you want to lock all the atoms contained in a 
folder, click the check box next to Lock Enclosed Atoms.

10. Create toolbars for the user or user class.

11. Create data filters for the user or user class.

12. Select the Save Desktop option from the File menu to save the 
arrangement. This arrangement displays the first time the user logs in 
to the SASIxp educational software.

13. Repeat steps 3 through 12 for each user or user class.

14. When you complete desktop setup for all users/user classes, log in to 
the SASIxp educational software using your own user ID and 
password and remove Security Officer status for those users.

Recreating SASI Modules

Once you have assigned folders and atoms to users, you can use the 
recreate options on the pop-up list of update options to recreate SASI 
Modules for selected user or for all users.

! Select Recreate SASI Modules for Selected Users if you want to 
recreate all folders and atoms for selected users. You can use this to 
fix corrupted atoms.
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! Select Recreate SASI Modules for All Users if you want to recreate all 
folders and atoms for all users. The program automatically selects this 
after you install a new version of the SASIxp educational software that 
contains changes to folders and atoms in your SASI Modules. This 
ensures that all users are working with the latest version of the SASIxp 
educational software folders and atoms.

! Select Recreate Entire Desktop for Selected Users if you want to 
recreate all folders and atoms for selected users, and also recreate 
their desktops. You can use this to fix problems related to corrupted 
atoms or to recreate user desktops from scratch.

! Select Recreate Entire Desktop for All Users if you want to recreate all 
folders and atoms for all users, and also recreate their desktops. You 
can use this to fix problems related to corrupted atoms or to recreate 
all user desktops from scratch.

Recreating SASI Modules (and Desktops)

1. Open the SASI Modules Setup atom. If you’ve just installed a new 
version of the SASIxp educational software that contains changes to 
your SASI Modules, a message alerts you that new SASI Modules are 
created for all users.

2. To change which folders and atoms are assigned to users, use the 
procedures given earlier for creating and updating SASI Modules. You 
must assign any new folders or atoms included in the new SASI 
Modules before these are available to users.

3. If you plan to use one of the recreate options that applies only to 
selected users, click the column heading for one user or user class, 
hold down the Shift key and click several.

4. Select one of the recreate options from the pop-up list of update 
options shown below the matrix.

5. Click Save to save all new entries.

Click Close to close the SASI Modules Setup atom. Users’ SASI 
Modules or their SASI Modules and desktops are updated the next 
time they log in to the SASIxp software.
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SASI Modules Setup Fields

Field Description

Folders & Atoms Lists all the folders and atoms included in 
your SASI Modules; there is a row for each 
folder and atom. Initially, only folders 
displays. To display all the atoms contained 
in one folder, double-click its name. To 
display all the atoms contained in all folders, 
select the Expand All Folders option from the 
Setup menu. The names of atoms are 
indented below the name of the folder they’re 
stored in.

Public The default access settings for folders and 
atoms; these are the settings that apply to 
most users. If no selection is made for a 
user’s class or for a user individually, user 
access to a folder or atom is based on what’s 
selected here. The Public column remains on 
display when you scroll horizontally to view 
other columns.

No User Class Contains sub-columns for all users who are 
not assigned to a user class.

User Sub-columns 
(Under No User Class)

Contains access settings for individual users 
who are not assigned to a user class; 
columns are labeled with User IDs assigned 
in the User atom. While User Class sub-
columns can be “folded” (hidden from view) 
and “expanded” (displayed), user sub-
columns under No User Class remain 
displayed at all times.
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Access Settings

Choices on the program-defined list of access settings that comes up 
when you click fields in Public, User Class, and User columns are as 
follows:

! Yes – indicates that a folder or atom is included in the SASI Modules 
for a user, a user class, or the Public. Any folder or atom previously 
marked with a No is added to the appropriate SASI Modules.

! No – indicates that a folder or atom should not be included in the SASI 
Modules for a user, a user class, or the Public. Any folder or atom 
previously marked Yes is removed from the appropriate SASI Modules.

! Blank – indicates that a user’s access to a folder or atom is determined 
by what’s selected in another column or row. It is not available from 
fields in the Public column.

User Classes Contains the access settings for each user 
class. The User Class column also contains 
sub-columns for individual users assigned to 
that class. Initially, only the User Class 
columns show. User sub-columns are 
“folded” or hidden from view. To display the 
sub-columns under one User Class heading, 
double-click that heading. To display the user 
sub-columns under all User Class headings, 
select the Expand All Classes option from the 
Setup menu.

User Sub-columns 
(Under User Classes)

Contains access settings for individual users 
who are assigned to a user class; columns 
are labeled with User IDs assigned in the 
User atom. Initially, the user sub-columns 
under User Class columns are “folded” or 
hidden from view. To display the sub-
columns under one User Class heading, 
double-click its heading. To display the user 
sub-columns under all User Class headings, 
select the Expand All Classes option from the 
Setup menu.

Field Description
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Update Options

Option Description

Update SASI Modules Updates users’ SASI Modules when you first 
assign folders and atoms or make changes to 
existing folder/atom assignments. Only newly 
assigned or removed folders and atoms are 
affected. This serves as the default option 
under most circumstances. However, if you 
install a new version of the SASIxp 
educational software that contains changes 
to the folders and atoms in SASI Modules, 
the program selects Recreate SASI Modules 
for All Users as the default.

Recreate SASI Modules 
for Selected Users

Recreates all the folders and atoms assigned 
to selected users. You can use this to fix 
problems related to corrupted atoms. Any 
folders and atoms shown on user desktops 
are not removed unless they have been 
marked No in the setup matrix. To select the 
column for one user or user class, click the 
column heading. To select columns for 
multiple users or user classes, hold down the 
Shift key and click column headings.

Recreate SASI Modules 
for All Users

Recreates all folders and atoms for all users. 
The program automatically selects this option 
after you install a new version of the SASIxp 
educational software that contains changes 
to folders and atoms in your SASI Modules. 
When you open the SASI Modules Setup 
atom, a message alerts you that new SASI 
Modules are created for all users.

Folders and atoms are not removed from 
user desktops or from SASIxp Modules 
unless they’ve been removed from SASIxp 
Modules. Folders and atoms are not added to 
SASIxp Modules unless you assign them.

You need to select Save before you can 
select a different update option from the pop-
up list.



Copyright © 2004 Pearson School Systems  65

Using the SASI Module Setup Atom

Recreate Entire Desktop 
for Selected Users

Recreates all folders and atoms for selected 
users, and also recreates their desktops. All 
folders and atoms assigned to each user are 
affected, and all folders and atoms on 
existing desktops are removed as new 
desktops are created. You can use this to fix 
problems related to corrupted atoms or to 
recreate user desktops from scratch.

Recreate Entire Desktop 
for All Users

Recreates all folders and atoms for all users, 
and also recreates their desktops. All folders 
and atoms assigned to each user are 
affected, and all folders and atoms on 
existing desktops are removed as new 
desktops are created. You can use this to fix 
problems related to corrupted atoms or to 
recreate all user desktops from scratch.

Option Description
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After you assign atoms to users, you can use the Security atom (in the 
System Setup folder) to fine-tune access to those atoms by assigning 
access rights to the data files and data fields they contain.

To assign varying levels of access, this atom gives you the following 
choices: No See, No Read, View Only, Update, Mass Update, and All. 
Rights for one file can be assigned to individual users, user class, and the 
public (users in general).

To tailor access rights to a user’s job duties, you can give that user 
different rights to different files (and fields) — you do not need to assign 
each user the same access level across the board. For example, you 
might give an attendance clerk all rights to attendance files, but view — 
only rights to student files.

Note that because the Security atom displays all users in the User atom 
and all files in your SASI Modules, it may include files for atoms that were 
not assigned to certain users in the SASI Modules Setup atom. However, 
only files for atoms that were assigned to a user or user class in Modules 
Setup are affected by what you do in the Security atom.

Security Atom

The data-file matrix displays when you open the Security atom. From the 
data-file matrix, you can access a data-field matrix for each file:

! The data-file matrix enables you to assign rights for specific data files. 
This matrix contains rows for all the SASIxp data files in SASI 
Modules, and columns for all users with records in the user atom.

! Data-field matrixes are where you assign rights for specific data fields. 
These matrices are designed for use when you want to provide access 
to most of a file, but limit access to certain fields within that file. Each 
data-field matrix contains rows for data fields in the selected file; the 
user columns shown are the same as those in the main data-file 
matrix. To display a data-field matrix, select Yes in the Field column, 
and double-click its file code. To return to the data-file matrix, click 
Files.
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In both matrix types, you can assign rights to users by selecting them from 
the program-defined list that pops up when you click fields in the Public, 
User Class, and User columns.

Security Fields

Column Description

Files File codes for all the SASIxp data files 
included in your SASI Modules. There is one 
row for each file. You can display the data-
field matrix for that file by double-clicking its 
file code in this column.
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Field Indicates whether access rights have been 
assigned to one or more data fields in a file. If 
you double-click the file name to access the 
field security, the Field column remains on 
display when you scroll right or left to view 
other columns. When you return to the Files 
screen by clicking Files, the system 
automatically places Yes in the Field column.

If you click Yes to change it to blank (No), the 
system displays a message asking if you 
want to disable the field security level for this 
file.

Public Default access rights for each file; these are 
the rights that apply to most users. If you 
assign no access right to a user’s class or to 
a user individually, user access to a file is 
based on what’s selected in this column.

No User Class Contains sub-columns for all users who are 
not assigned to a user class.

User Sub-columns 
(Under No User Class)

Contains access rights for individual users 
who are not assigned to a user class. 
Columns are labeled with user IDs assigned 
in the User atom.

User Classes Contains the access rights assigned to each 
user class; each user class column also 
contains sub-columns for individual users 
assigned to that class. Initially, only the user 
class columns display. User sub-columns are 
“folded” or hidden from view.

User Sub-columns 
(under User Classes)

Contains the access rights for individual 
users who are assigned to a user class; 
columns are labeled with user IDs assigned 
in the User atom. Initially, only the user class 
columns display; user sub-columns are 
“folded” or hidden from view.

Column Description
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Data-Field Matrix

Data-field matrices enable you to assign rights for specific data fields when 
you want to provide access to most of a file, but limit access to certain 
fields within that file. Each data-field matrix contains rows for data fields in 
the selected file. The user columns display the same as those in the main 
data-file matrix. To display a data-field matrix, select Yes in the Field 
column for a file, and double-click its file code. To return to the data-file 
matrix, click Files.

Security Data Field Matrix Fields

The Public, User Class, and User columns shown in data-field matrices 
are exactly the same as those shown in the data-file matrix. The only 
differences between the two types of matrices are as follows:

! Data-file matrices do not contain a Field column.
! Data-field matrices contain a Fields column instead of a Files column. 

The Fields column displays names of all the fields in the selected file to 
which access rights can be assigned.
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Access Rights

The choices on the program-defined list of access rights are the same for 
both the data-file and data-field matrixes.

Access Right Description

No See At the file level, users assigned this right 
cannot open the atom that contains the 
selected file. An alert message displays if 
they try. In addition, the file is not displayed in 
the Query atom.

At the field level, the selected field does not 
display for those users, even if it contains 
data.

No Read At the file level, users assigned this right 
cannot open the atom that contains the 
selected file; an alert message displays if 
they try. In addition, the file is not displayed in 
the Query atom.

At the field level, the selected field displays, 
but remains blank, even if it contains data.

View Only At the file level, users assigned this right can 
open the atom that contains the selected file 
and display records. They can also work with 
the file in the Query atom. However, they 
cannot enter or change data in that file or 
perform a mass change from Query.

At the field level, the selected field and any 
data it contains displays, but users cannot 
enter or change data in that field.

Update At the file level, users assigned this right can 
open the atom that contains the selected file, 
enter or change data, and add or delete 
records. However, they won’t be able to 
perform a mass change from Query.

At the field level, users can enter or change 
data in that field.
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Assigning Access Rights

These steps are the most efficient way to assign access rights to data files 
and data fields:

1. Go to the Public column and assign the access right that should apply 
to most users. Access is based on the values in this column if the User 
Class and User columns for a user are blank. The default selection for 
all files is All.

2. If the access right for a user class should be different from the one 
assigned in the Public column, go to the User Class column for that 
class and enter it. Access is based on what is entered in a User Class 
column if the User column for a user is blank.

3. If the access right for an individual user should be different from the 
one assigned in the Public column and in the user’s User Class 
column, go to the User column for that user and enter it. Access is 
based on what is entered in the User column for a user, no matter 
what’s entered in the Public column or User Class column.

Assigning Access Rights for Data Files

1. Open the Security atom and click the file code for the file for which you 
are assigning access to highlight its row.

2. Click the Public field for the selected file. When the list of access rights 
displays, select the option you want to assign to most users. The 
default selection for all files is all.

Mass Update At both the file and field levels, users 
assigned this right can do everything that 
users assigned the update right can do. In 
addition, they can mass change data in 
multiple records from the Query atom.

The Change option in Query is available only 
to users who are security officers.

All At the file level, users assigned this right can 
use all options available for working with files, 
including creating and deleting files.

At the field level, users can use all options 
available for working with the selected field.

Access Right Description
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3. To assign a different right to a user class, click the field for the selected 
file in the appropriate User Class column. When the list of access 
rights displays, select the option you want. The access right you enter 
here applies to all users in that class, unless you enter different rights 
for individual users.

4. To assign a different right to individual users, click the field for the 
selected file in the User column and select the access right you want.

5. To assign access rights to certain fields in the selected file, follow the 
steps in the next section.

6. Repeat Steps 2 through 5 for each data file you want to assign access 
rights for.

7. Click Save to save all new entries, including any entries made in data-
field matrices (click Undo to erase all new entries).

8. Click Close.

Assigning Access Rights for Data Fields

1. From the data-file matrix in the Security atom, select Yes in the Field 
column for the file you want to work with; you can do this by clicking its 
Field field.

2. Double-click the file code for the selected file; the system displays the 
data-field matrix for that file.

3. Click the name of the field you are assigning access rights for to 
highlight its row.

4. Click the Public field for the selected field. Use the pop-up list to select 
access rights you want to assign to most users. The default selection 
for most fields is All.

5. If you want to assign a different right to a user class, click the field for 
the selected field in the appropriate User Class column. Use the pop-
up list to select access rights you want to assign to the user class. The 
right you enter here applies to all users in that class, unless you enter 
different rights for individual users.

6. If you want to assign a different right to individual users, click the field 
for the selected field in the User column for each user. Use the pop-up 
list to select access rights you want to assign to the user.

7. Repeat Steps 3 through 6 for each field you want to assign access 
rights for.

8. Click Save to save all new entries.
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9. Click Files to close the data-field matrix and return to the data-file 
matrix.

10. Click Save in the data-file matrix to permanently save all new entries in 
the data-field matrix you just worked in and in the data-file matrix (click 
Undo to erase all new entries in both matrices).

11. Click Close.

Duplicating an Entry

1. Select an access right in one field as you normally would (click in the 
field, drag the mouse to highlight the right you want on the list that 
displays, and release the mouse to select it).

2. For each subsequent field, hold down the Option key (Macintosh) or 
the Alt key or right mouse button (Windows) and click in the field. The 
access right selected last displays in each field). You can work 
consecutively (by row or column), or randomly, jumping from field to 
field.

Duplicating an Entire Column

1. To copy a column of settings from one user to another, click and hold 
on the title field for the column you want to copy to highlight the entire 
column.

2. Drag and drop the highlighted column to the column where you want it 
copied.
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The Create New Files atom (in the File Management folder) creates the 
empty data files the system needs for recording data. You can use this 
atom when you first set up a school in the SASIxp software, or as needed 
throughout the year.

The files you’ll need to create depend on whether or not you are 
converting existing data and which atoms you plan to use:

! If you are converting data for a school, the appropriate files for that 
data are created automatically.

! If you are not converting data, you’ll need to create all required files.
! If you do not plan to use certain atoms, such as Master Schedule or 

Course, you do not need to create files for those atoms.

Create New Files Atom

The Create New Files atom contains one matrix listing the data files in 
your SASI Modules (the entire collection of folders and atoms your school 
is licensed to use) and several function buttons and checkboxes used in 
creating files.
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Creating New Files

You can use the Create New Files atom to create new files or to replace 
existing files that are marked with a Yes in the Created column of the File 
Name matrix. Keep in mind that when you replace existing files, any data 
they contain is deleted. Also, if you are not converting data, you’ll need to 
add records to files and enter data.

Creating New Files

1. Open the Create New Files atom.

2. In the School Name field, use the pop-up list field to select the school 
that you are creating files for. If the correct school is already displayed, 
skip to Step 3.

3. In the Year field, enter the year you are creating files for. If the correct 
school year is already displayed, skip to Step 4.

4. Select the Show all file names option to display all files available in the 
File Name matrix.

5. From the matrix, select the names of the files you want to create:

! To select all files displayed at once, click Select All.
! To select one file, click its field in the Code column.
! To select more than one file but less than all, hold down the Shift 

key and click each file’s field in the Code column.

6. Click Create. The program begins creating files. The name of each file 
selected displays in the message center as the program creates it. 

! If a file already exists, warning message displays. Click OK to 
overwrite an existing file with a new one, or click Cancel to keep 
existing data and skip to the next file.

! If a file already exists and data can be carried over from one year to 
another, a message asks you if you want to copy last year’s file to 
this year’s. Click Yes to copy or No if you do not want to copy last 
year’s data.

7. After the system creates the selected files, click Select None to clear 
highlighting from the selected rows.

8. Click Close.
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Replacing Existing Files

1. Open the Create New Files atom.

2. In the School Name field, use the pop-up list to select the school that 
you are creating files for.

3. In the Year field, enter the year you want to create files for. If the 
correct school year is already displayed, no entry is required.

4. Click the check box next to the Show all file names field to display all 
the files available in the atoms listed in the matrix.

5. From the matrix displayed, select the files you want to replace:

! Select all files currently displayed in the matrix by clicking Select 
All.

! To select one file, click its field in the Code column.
! To select more than one file but less than all, hold down the Shift 

key and click each file’s field in the Code column.

6. Select the Replace existing file(s) option to replace existing files with 
no warning message. However, a message displays asking if you want 
to copy last year’s definition files to this. Click Yes or No.

7. Click Create. The program replaces existing files and creates files that 
are selected in the matrix but do not yet exist. The name of each file 
displays in the message center as the program replaces it.

8. After the system replaces the selected files, click Select None to clear 
highlighting from the selected rows.

9. Click Close.

Create New Files Fields

Field Description

School Name Name of the school currently selected in the 
Create New Files atom, and enables you to 
select a different one.

Year Last two digits of the school year currently 
selected in the Create New Files atom and 
enables you to select a different one. 
Remember that 98-99 displays as 98.
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Code and File Name 
Matrix

Data files used by the SASIxp educational 
software atoms. Each row is devoted to one 
file. Initially, just the file for the main atom in a 
module displays. When you select the Show 
all file names box, the matrix displays files for 
additional atoms in various modules, which 
are sub files to the main file.

The Code column contains the code for each 
module or file.

The File Name column contains the file name 
for each atom or file. The Created column 
identifies whether or not a file has been 
created. Yes in a field in this column means a 
file exists. A blank field means it does not 
exist.

Select All Button Enables you to highlight and select all the file 
names currently displayed in the matrix at 
once. If you want to select one file, click its 
field in the Code column. If you want to select 
more than one but less than all, hold down 
the Shift key and click each file’s field in the 
Code column.

Select None Button Enables you to deselect all the file names 
currently highlighted in the matrix at once. It 
is not active unless you select one or more 
rows.

Close Button Closes the Create New Files atom.

Field Description
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Create Button Initiates the file creation process for the 
selected files, and is only active when one or 
more rows are selected. The name of each 
file displays in the message center as it is 
created.

If a file already exists, a message displays 
when you click Create. If you want to delete 
all data contained in the existing file and 
create a new one, click OK. If you want to 
keep the existing data and file, click Cancel.

If a file already exists and data can be carried 
over from one year to another, the system 
displays a message asking if you want to 
copy last year’s file to this year. Click Yes or 
No.

Show all file names Enables you to display files for additional 
atoms in various modules. Initially, just the 
file for the main atom in a module displays. 
Typically, the additional files are for atoms 
used to perform setup, such as the 
Attendance Setup atom. The names of 
additional files are indented to the right in the 
File Name column, under the name of the 
main file for a module.

If you create a main file (ASTU) without 
selecting Show all file names, the system 
automatically creates the subfiles.

Replace existing file(s) Enables you to replace existing files without 
getting a warning message that they already 
exist. Keep in mind that all data contained in 
the existing file is deleted when you replace it 
with a new file. The replace option applies 
only to the rows selected (all, several, or 
none) when you click Create.

Field Description
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Use Database Definition Displays files that may not display in the 
“Select files to create” list of the Create New 
Files atom. Examples of these files include 
user-defined files created with File Definition 
Pro and the SASIxp control files. This feature 
does not copy last year’s data to the current 
year, and should not be used in most cases. 
Use this feature only as a last resort when 
you are unable to create a new version of a 
particular file.

This feature may produce undesired results 
because last year’s data is not copied into the 
current year. Contact Pearson School 
Systems Support before using this feature.

Field Description
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The Next ID atom (in the System Setup folder) enables the system to 
automatically supply ID numbers in sequential order as records are added 
to files in various atoms. It is intended for use by the system administrator 
and is not typically available to other users.

The numbers affected by settings in the Next ID atom can include IDs for 
students, teachers, and courses as well as link numbers for related 
records and numbers for forms and scanner sheets.

After the current number is used, the Next ID atom advances to the next 
number and keeps it ready for the next record. You can view the next 
numbers available at any time by opening the Next ID atom.

Use the Next ID atom when you are setting up the SASIxp software and 
when you want to use automatic numbering for certain parts of the 
database. You can either use the program defaults for numbering, or enter 
numbers of your choosing. (If you are using converted data, the next 
numbers available from that data are entered in the Next ID atom 
automatically.)

In addition, if you want the program to automatically assign a number in a 
user-defined field, you can add that field to the Next ID atom yourself.

Finally, if you want users to enter some numbers manually, you can 
change settings in the Next ID atom to force manual entry.

Options on the Next ID Menu

Menu Description

Update Selected Next 
IDs

For the Next IDs that have been highlighted, 
this command sets the current number to the 
next available number. Any Next IDs that 
have been set to 0 are not changed. This 
menu selection is activated only after you 
have highlighted one or more Next ID 
Numbers.
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Next ID Atom

The Next ID atom contains one matrix. Each row in the matrix contains the 
set of ID numbers for one file.

Performing Next ID Setup

If you want the program to automatically assign the numbers shown in the 
Next ID atom, you can leave this atom set up as is. However, if you want to 
change a starting number or the next number, or if you want users to enter 
numbers manually, follow these steps.

Update All Next IDs Increase all Next ID numbers to the next 
available number. Any Next IDs that have 
been set to 0 are not changed. This process 
can take a long time.

Enable Full Editing Scheduled for version 4.0.

Menu Description
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Setting Up Numbers for Next ID

1. Open the Next ID atom.

2. If you want to change the description for an ID number, type a new 
description in the Description field.

3. If you want to change the starting number or next number for an ID, 
click in its field in the Next Number column and type a new number. 
Type zero if you want to manually assign the number.

4. Click Save to save your changes. (Click Undo if you want to revert to 
previous entries.)

5. Click OK to confirm that you want to save changes.

Updating Selected Next IDs

If Next IDs are set improperly, you can set all or selected next IDs to the 
next available number (last-used number plus one).

1. Open the Next ID atom.

2. Highlight the Next IDs you want to update by clicking the line number. 
You can highlight several IDs by holding down the Shift key while 
clicking.

3. Select Update Selected IDs from the Next ID menu. The highlighted 
IDs (except those set to 0) are set to the next available number.

4. Click Save.

Updating all Next IDs

1. Open the Next ID atom.

2. Select the Update All IDs option from the Next ID menu. All IDs (except 
those set to 0) are set to the next available number.

3. Click Save.
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Next ID Fields

Field Description

Ln Line number for each row.

File Code Name of the SASIxp file that contains the 
field where automatic numbering can be 
used.

Description Description of each number; this description 
displays only in the Next ID atom.

Next Number Next number that is used for each new ID, 
link, form, or sheet added to a file. The 
starting number for each series of numbers 
can be either the program default or a 
number you choose; you can enter different 
starting numbers at any time. Be sure starting 
numbers you assign do not exceed the 
maximum allowed for the file to which the 
Next Number is assigned. If you set Next 
Number to zero (0), it forces the user to enter 
the next number manually. The program 
checks for duplicates and prompts users to 
enter a non-duplicate.

Next IDs that are link numbers must not be 
set to zero.
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Use the Teacher atom (Basic Scheduling or Mass Scheduling) to set up 
your teacher records. This atom enables you to enter professional 
information for each teacher and assign the Teacher IDs. Personal and 
home information is stored in the Staff atom.

As teachers are added in the Teacher atom, they are automatically added 
to the list in the Teacher List atom. This list displays the names and IDs of 
all the teachers at a school.

Options on the Teacher Menu

Option Description

Courses Taught Opens the Teacher Course Definition atom 
so that you can record the courses and 
number of sections taught by the teacher 
currently displayed in the Teacher atom.

Attach Teacher Photo Enables you to attach a photo to a teacher 
record. The teacher’s photo is then shown in 
the photo box in Teacher atom pages and in 
the Mini Pic box in the message center 
whenever the teacher’s record displays.

Change Name, SSN, ID Unlocks the fields in the top line of Teacher 
atom pages so that you can make changes to 
a teacher’s name, Social Security Number, 
and/or Teacher ID. Normally, this line is 
locked to prevent accidental change.
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Teacher Atom

The Teacher atom contains two screens:

! General Info
! Schedule Pro

General Information Screen

The General Info screen enables you to add teachers and enter 
professional information about each one.

Setting Up a Teacher Record

How you set up teacher records depends on how your school is defined in 
the School atom:

! If your school is defined as Elementary, No Schedules, setting up 
teacher records consists of adding them in the General Info tab.

! If your school is defined as Secondary or as Elementary, With 
Schedules, and you are using Schedule Pro, setting up teacher 
records consists of adding them in the General Info tab, then entering 
teacher scheduling data in the Schedule Pro screen.

The Schedule Pro screen is available if your school is using Schedule 
Pro and has set up scheduling requirements in the Schedule Pro Global 
Scheduling Specifications.
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Adding a Teacher Record

1. Open the Teacher atom. The system displays the General Info screen.

2. Select the Add Teacher option from the Data menu. Asterisks display 
in the Tch ID field. This is filled in with the next number available from 
the Next ID atom when you save the record.

3. In the Last Name field, type the teacher’s last name. Also complete the 
First Name and Middle Name fields.

4. In the Soc Sec No field, type the teacher’s Social Security Number.

5. In the Short Name field, type an abbreviated version of the teacher’s 
name. This is entered in Enrollment and Student records with the 
Teacher ID. If left blank, the system defaults to the teacher’s last name.

6. Fill in the remaining fields as appropriate.

7. Once general information is complete, click Save to add the teacher 
record.

Updating a Teacher Record

You can update teacher records from the Teacher atom as needed. To 
change data in the first line of a teacher record, use the Change Name, 
SSN, ID option on the Teacher menu.

Updating a Teacher Record

1. Open the Teacher atom and display the record you want.

2. Make changes as needed. If the fields are on the Scheduling Info 
page, use the page box or a page advance arrow to display that page.

3. Click Save to save all new entries (click Undo to revert to previous 
entries in all fields).

4. Click OK to confirm that you want to save all changes.

5. After you save changes to a teacher record, click Close to close the 
Teacher atom.

Changing Data in the Name, SSN, ID Line

1. From either page in the Teacher atom, display the teacher record you 
want.

2. Select the Change Name, SSN, ID option from the Teacher menu.
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3. Make the appropriate changes.

4. If you want to work in any fields below the Name, SSN, ID line, make 
changes as needed.

5. Click Save to save all new entries (click Undo to revert to previous 
entries in ALL fields).

6. Click OK to confirm that you want to save changes.

Inactivating and Deleting Teacher Records

You can work from the Teacher atom to delete, inactivate, or activate 
teacher records using options on the Data menu. The Inactivate option on 
this menu changes to Activate when an inactive record displays.

! Inactivating a teacher changes the status of his or her record to 
inactive. Because inactive records are not locked or removed from the 
database, you can display or reactivate them at any time. To identify 
the records of inactive teachers, their names are enclosed in 
parentheses in the title bars of teacher-related pages. In addition, their 
status is marked as I in matrices produced by the Find function.

! Deleting a teacher from the Teacher atom permanently removes their 
file from the database.

Inactivating a Teacher Record

1. Open the Teacher atom and display the record you want to inactivate.

2. Select the Inactivate Teacher option from the Data menu. The program 
encloses the teacher’s name in parentheses in the title bar to indicate 
that the teacher is inactive.

3. Click Save to save the change.

4. Click OK to confirm that you want to save the change.

Reactivating an Inactive Record

1. Open the Teacher atom and display the record you want to reactivate.

2. Select Activate Teacher from the Data menu. Parentheses are 
removed from the teacher’s name in the title bar.

3. Click Save to save the change. Click OK to confirm that you want to 
save the change.
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Deleting a Teacher Record

1. Open the Teacher atom and display the record you want to delete.

2. Select Delete Teacher from the Data menu. All data is cleared from the 
screen and the teacher’s record is removed permanently from the 
database. Click OK to confirm the delete.

3. Click Close.
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General Information Fields

Field Description

Last Name Teacher’s last name. This is a required field.

First Name Teacher’s first name.

Middle Name Teacher’s middle name.

Gnrtn
(GNR table)

Teacher’s generation code, such as Jr. or Sr.

Soc Sec No Teacher’s Social Security Number.

Tch ID Teacher number assigned to the teacher. 
This is filled in with the next number available 
from the Next ID atom when you save the 
record.

If your school is set up as an Elementary 
School, No Schedules, class lists are 
determined by the teacher ID entered.
If your school is set up as a Secondary 
School or as an Elementary School With 
Schedules, the Teacher IDs entered here are 
used by the program to do scheduling.

Short name Abbreviated version of the teacher’s name. 
This is entered in Enrollment and Student 
records with the Teacher ID, and also prints 
on report cards and class rosters.

Employee No Teacher’s school-assigned employee 
number. (This is not to be confused with the 
Staff ID in the Staff Info atom.)

Gen
(GEN table)

Teacher’s gender. Use the pop-up list to 
select Male or Female.

Eth
(ETH table)

Teacher’s ethnic code. Use the pop-up list to 
select the appropriate ethnic code.

Expr Indicates how many years of teaching 
experience the teacher has.
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Degree
(CDL table)

Highest degree the teacher has earned.

Couns Indicates whether the teacher is also a 
counselor. An X indicates the teacher is a 
counselor; blank indicates the teacher is not.

Telephone Teacher’s phone number at the school. 
Because an area code is not needed, the 
field does not contain space for this.

Extn Extension to the teacher’s number at the 
school.

Mailbox Teacher’s school mailbox.

Home Room Teacher’s homeroom number.

Trk Track the teacher is assigned to; this field 
displays only if the school is set up for tracks.

MaxStu Maximum number of students that can be 
assigned to the teacher’s class or classes.

Dept 1 — Dept 4
(DPT table)

Identify the teacher’s primary areas of 
instruction. You can select up to four 
departments for a teacher. Select a 
department from the school-defined pop-up 
list. (DPT table)

License Number Teacher’s license number.

Field Description
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Schedule Pro Screen

If you have Schedule Pro installed and implemented, you can use the 
Schedule Pro screen to define scheduling information for your teachers. 
See the SASIxp Schedule Pro Training Guide for the field definitions.

If you do not have Schedule Pro, this screen does not display.
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The Course atom (in the Basic Scheduling or Mass Scheduling folder) 
enables you to set up and maintain a record for each course taught at your 
school. Basic information in course records includes:

! Course ID and title
! Duration
! Gender restrictions 
! Low and high grades
! Whether a course is regular, honors, or non-academic
! Course credit
! Weight
! Fees
! Effective date and expiration date
! Department code
! Alternate course IDs
! State course IDs
! Subject areas
! College/university subject areas

The Course atom also provides forms for entering a complete course 
narrative, summer school information, and scheduling information to be 
used in the Schedule Pro module.

Option on the Course Menu

Option Description

Change ID and Title This option enables you to make changes in 
the fields that display in the first line of all 
course forms. This data consists of course 
ID, course title, long course title, and 
duration. After you add a course, the first line 
is locked to prevent accidental changes. 
Selecting Change ID and Title from the 
Course menu unlocks it.
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General Info Screen

The General Info screen enables you to add courses and enter basic 
information about each one.

Setting Up a Course

Adding a Course Record

1. Open the Course atom. The system displays the Course General Info 
tab.

2. Select the Add Course option from the Data menu. Asterisks display in 
the Course ID field. The system assigns the next number available 
from the Next ID atom when you save the record.

3. In the Course Title field, type the appropriate course title.

4. In the Long Course Title field, type the long course title.

5. In the Duration field, use the pop-up list to select the appropriate 
duration of the course.

6. Fill in the remaining fields on the screen.

7. When you reach the last field on the General Info tab of the Course 
atom, click the page advance down arrow or on the page box to display 
the Course Narrative screen.
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8. Click the Course Narrative box to position the cursor. You can enter 
text here just as you would with most word processors. Edit this text 
using options on the Edit menu.

9. Click the page advance down arrow or click the page box on the 
Scheduling Info tab of the Course atom to display the Summer School 
tab.

10. In the Apportionment field, use the pop-up list to select the appropriate 
option.

11. In the Course Type field, use the pop-up list to select the appropriate 
option.

12. Select whether the course minutes should count toward total 
Proficiency minutes or total Core minutes in the Proficiency/Core field.

13. When you complete the summer school tab, click the page advance 
down arrow or the page box to display the Schedule Pro page. The 
fields on this page of the Course screen are used in Schedule Pro only. 
You can skip this tab for now and enter scheduling information later.

14. Click Save to save your entries and update the course record.

Updating a Course Record

You can update course records from the Course atom as needed. To 
change data in the first line of a course record, use the Change ID and 
Title option on the Course menu.

Updating a Course Record

1. Open the Course atom and display the record you want.

2. Locate the first field to be changed and make the appropriate changes. 
Continue making any changes you need to. If the fields are on the 
Course Narrative, Summer School, or the Schedule Pro tab, use the 
page box or a page advance arrow to display that tab.

3. Click Save to save all new entries.

4. After you save changes to a course record, click Close to close the 
Course atom.
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Changing a Course ID or Title

1. From any page in the Course atom, display the course record you 
want.

2. Select the Change ID and Title option from the Course menu.

3. Click the first field to be changed and make the appropriate changes.

4. If you want to work in any fields below the ID and Title line, click those 
fields and make changes as needed.

5. Click Save to save all new entries, then close the atom.

Inactivating and Deleting Course Records

You can work from the Course atom to delete, inactivate, or activate 
course records using options on the Data menu. The Inactivate option on 
this menu changes to Activate when an inactive record displays:

! Inactivating a course changes the status of the record to inactive. 
Because inactive records are not locked or removed from the 
database, you can display or reactivate them at any time. To identify 
the records of inactive courses, the system encloses their names in 
parentheses in the title bars of course-related forms. In addition, their 
status is marked as I in matrices produced by the Find function.

! Deleting a course from the Course atom permanently removes the 
record from the database.

Inactivating a Course Record

1. Open the Course atom and display the record you want to inactivate.

2. Select the Inactivate Course option from the Data menu. The system 
encloses the course’s name in parentheses in the title bar to indicate 
that the course is inactive.

3. Click Save to save the change (click Undo to keep the course active).

4. Click OK to confirm that you want to save the change.

Pearson School Systems does not recommend deleting courses 
because they may be in the student’s Course History record.
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Activating an Inactive Record

1. Open the Course atom and display the record you want to activate.

2. Select the Activate Course option from the Data menu; parentheses 
are removed from the course’s name in the title bar.

3. Click Save to save the change; (click Undo to leave the course record 
inactive).

4. Click OK to confirm that you want to save the change.

Deleting a Course Record

1. Open the Course atom and display the record you want to delete.

2. Select the Delete Course option from the Data menu. All data is 
cleared from the screen and the course’s record is removed 
permanently from the database.

3. Click OK to confirm the deletion.

4. Click Close.

General Info Fields

Field Description

Course ID ID of the course.

Course Title Title of the course.

Long Course Title Longer version of the course title.

Duration Duration of the course, such as Year, 
Semester, Trimester, or Quarter. For 
example, the SX or QX indicates that the 
course can be offered any semester or 
quarter, respectively.

Gen Specifies whether the course has any gender 
restriction. Blank is for no restriction, F is for 
Females only, and M is for Males only.

Low
(GRD table)

Lowest grade that can be scheduled into this 
course.
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High
(GRD table)

Highest grade that can be scheduled into this 
course.

N/H
(ACA table)

Non-academic, regular, or honors code for 
the course.

! A blank indicates that it is an academic 
course and is counted in the GPA with 
standard weighting.

! N indicates that it is a non-academic 
course that is not counted in the 
academic GPA.

! H indicates that it is an honors course, 
and is added to the GPA calculation 
according to the weighting assigned to it 
in the GPA Definitions atom.

Credit Indicates the credit value for the course for 
the term specified for transferring credits to 
course history.

Max Credit Maximum credit normally allowed to be 
earned in this course, including up to two 
decimal places, if the course can be 
repeated. The Max Credit and Credit 
amounts are used to determine students who 
have taken any course too many times. Used 
by the EDI atom.

Weight GPA weight code for the course.

Fee 1 Fee charged for taking the course.

Fee 2 Second fee charged for taking the course.

Eff Date Date that a change to a course’s status 
becomes effective. This field is informational 
only.

Exp Date Date that a course becomes inactive. This 
field is informational only.

Department
(DPT table)

Name of the department this course belongs 
to.

Field Description
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College Prep
(CPT table)

Enables you to mark a course as college 
preparatory or honors by selecting from a 
pop-up list. This designation displays on 
transcripts.

Alternate ID 1 Alternate course ID. This is a user-defined 
field and can be used for any additional 
information that you need to store about a 
course ID. For example, if your school uses a 
different course ID from the one used by the 
district, you could enter it here. The 
information in this field can be queried and 
used for sorting.

Alternate ID 2 Second alternate course ID.

State ID 1 State ID for this course.

State ID 2 Second state ID for this course.

Mass Change Under development.

Subject Areas
(SUB table)

Subject areas to which this course may apply 
when computing graduation status.

College Areas
(CAR table)

Subject areas to which this course applies for 
college entrance requirements.

University Areas
(UAR table)

Subject areas to which this course applies for 
university entrance requirements.

Prerequisite Course number of a course that has to be 
scheduled before this course in the same 
school year. For example, if you are setting 
up History 102 (a second semester course) 
and History 101 must be taken in first 
semester, enter “101" in this field. This field 
tells the scheduling program to put students 
into 101 in the semester before they are put 
into 102.

Regency Indicates whether or not the section is a 
Regency course.

Course Category Used in the Tuition atom.

Field Description
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Qualifies for Aid Flags this course as qualifying for financial 
aid. (Used in Tuition atom.)

CBEDS Grp
(CBEDS report)

Marks courses you want included in Part D of 
the California Basic Educational Data System 
report.

CBEDS Voc Ed
(CBEDS report)

Marks courses you want identified as 
vocational education courses and included in 
Part E of the California Basic Educational 
Data System report.

Voc Program Records a state-required vocational program 
code for this course.

Voc Course Records state-designated course numbers 
for vocational education courses.

Duplicates Setting this field to Yes enables students to 
be scheduled into multiple sections of this 
course at the same time and to earn separate 
grades for each of the sections of the same 
course.

Field Description
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Course Narrative Screen

Use the Course Narrative screen to enter the complete description of the 
course.

Course Narrative Field

Field Description

Course Narrative Large text field for entering the complete 
description of the course.
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Course Summer School Screen

The Summer School screen enables you to identify apportionment 
information and course type for a course. For the system to correctly 
calculate apportionment minutes, you must tag every summer school 
course as either a proficiency course or core course. You do not need to 
define this information for non-summer school courses.

Course Summer School Fields

Field Description

Apportionment Category
(APC table)

Apportionment category for the course. 
Selections might include Proficiency, Core, 
Community College, Special Education, and 
so on.

Course Type
(CRT table)

Type of course. Selections might include 
English, Math, and so on.

Proficiency/Core Indicates whether apportionment minutes for 
the course should be included in proficiency 
totals or core totals.
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Course Scheduling Screen

If you have Schedule Pro installed and implemented, you can use the 
Schedule Pro screen to define scheduling information for your courses. 
See the Schedule Pro Training Guide for the field definitions.

If you do not have Schedule Pro, this screen does not display.
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Schools that use rotating periods in their schedules can define the manner 
in which the periods change using the Rotation Definition atom (in the 
System Setup folder).

! First, define the days in the rotation cycle by naming them and 
assigning a schedule code to the name. You can do this task manually 
or by selecting a default setting.

! Next, set up the rotation of periods for each day in the cycle. Use the 
options to select a default rotation where each bell period changes by 
one period each day, or assign the periods to different hours.

The Rotation Definition atom contains two screens:

! Rotation Days
! Rotation Periods

Rotation Definition Screen

The Rotation Definition screen enables you to define the days in the cycle 
by assigning them a day of the week and a title.
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Defining Period Rotation

Schools that have periods that rotate to different hours on each day of the 
week can set up the rotation definition atom to record the cycles (number 
of days and number of periods to rotate). The two options for setting 
rotation days are:

! Enable the system to create default rotation file.
! Create a user-defined rotation file.

Defining a Default Rotation File

1. Open the Rotation Definition atom.

2. Click the Create Default File icon that displays on the Rotation Days 
screen.

3. Create the Rotation file using A-B-C-D for the day code and A-day, B-
day, C-day, D-day for the title. The program uses capital letters from A-
Z, then lower case letters from a-v to fill the definition matrix. You can 
define up to 48 schedule cycle days.

Creating a User-Defined Rotation File

1. Open the Rotation Definition atom.

2. Click Number of Days in Cycle field and select from the pop-up list of 
numbers.

3. In the Day Code field on line 1, enter a 1-letter code for the name of the 
day (for example, “R” for Red day).

4. In Sched Code field, assign a schedule code to this day code by 
selecting from the pop-up list or typing a valid schedule code. 
(Schedule codes are defined on the Schedules tab of the School 
atom.)

5. In the Title field, enter a title for this day (for example, Red Day).

6. Repeat for all of the days in the cycle, then click Save to save rotation 
days information.
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Rotation Definition Fields

Field Description

Line Line number for each day.

Day Code One-character code to identify the day.

Sched Code Schedule code assigned to this day. Select 
from the pop-up list or type the letter name 
for the day in the cycle. The pop-up list is 
created from the settings made in the 
Scheduling Cycle field on the Schedules tab 
of the School atom.

Title Name for this day. Some schools use colors 
or presidents’ names.

Create Default File When you click this icon, a default rotation file 
is created (or recreated if one already exists) 
and it is filled with rotation day codes that are 
alphabetical (A, B, C, D, etc.), and titles for 
the rotation days based on the day codes (A-
Day, B-Day, C-Day).
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Periods Screen

The Rotation Periods screen enables you to define which periods meet 
during which hours throughout the cycle.

Setting Up Rotation Periods

You can set up rotation periods in one of three ways:

! Default periods (no rotation of schedule).
! Default rotating schedule (each period moves forward one hour each 

day).
! User-defined rotating schedule (periods are assigned to hours of the 

day by the user).

Rotation Periods Fields

Field Description

Bell Per The hour that each class meets. If your 
school uses rotating periods, the hour the 
class meets is called the bell period, while the 
period for which the class is scheduled (in the 
Sections atom) is called the scheduled 
period.
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Non-Rotating Periods

Sched Columns There is a column for each day in your 
scheduling cycle, containing the title and the 
schedule code defined on the Rotation Days 
page. In each field, you can select a 
scheduled period number for each bell period 
(hour) or enable the program to fill the matrix 
with default period numbers. Do this by 
selecting Default Periods (no rotation) or 
Default Periods, Rotating from the rotation 
definition menu, or by clicking one of the 
icons shown at the bottom of the screen.

Fill Non-Rotating When you click this icon, normal period 
scheduling (1st period during first hour, 2nd 
period during second hour, etc.) is 
automatically entered. This causes your 
school to have a non-rotating period 
schedule.

Field Description
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Defining Default Periods (No Rotation)

1. Use the page advance arrow to change to the Rotation Periods page 
of the Rotation Definition atom.

2. Click the Fill Periods Non-Rotating icon. Normal (non-rotating) periods 
are assigned to each day of the cycle, then click Save to save the 
period setup.

Rotation Icon

Rotating Periods

Icon Description

Fill Rotating When you click this icon, the matrix is filled 
automatically with a rotating period schedule 
where each period moves forward one hour 
(or bell period) each day of the cycle.
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Defining the Default Rotating Schedule

1. Use the page advance arrow to change to the Rotation Periods page 
of the Rotation Definition atom.

2. Click the Fill Periods Rotating icon. Periods are assigned to hours (bell 
periods) by moving each period forward one hour each day.

3. Click Save to save the period setup.

Setting Up a User-Defined Rotating Schedule

1. Use the page advance arrow to change to the Rotation Periods page 
of the Rotation Definition atom.

2. Click each field of each day and select the period number that meets 
that hour.

3. Repeat for each bell period for each day in the cycle.

4. Click Save to save the period setup.

Rotation Definition Menu Options

Field Description

Create Default Rotation 
File

Tells the program to recreate and fill in the 
rotation days matrix automatically. When you 
do this, any entries you have already made 
on the Rotation Days page are deleted and 
filled in with defaults.

Default Periods Enters normal period scheduling (1st period 
during first hour, 2nd period during second 
hour, etc.) on the Rotation Periods page. The 
effect is to turn off period rotation. This menu 
option is available only when you are on the 
Rotation Periods page.

Default Periods, 
Rotating

Enters a rotating period schedule where each 
period moves forward one hour (or bell 
period) each day of the cycle. This menu 
option is available only when you are on the 
Rotation Periods page.
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The Attendance Setup atom contains seven forms:

! Calendar
! Reporting Periods
! Bell Schedule
! Absence Reasons
! Other Options
! Scanner Options
! Advanced

Calendar Tab

The Calendar tab is a matrix that enables you to set up the Attendance 
Calendar for the current school year. This is used by all Attendance atoms 
(Daily Attendance, Period Attendance, Class Attendance) as a reference 
for regular attendance days, vacation days, holidays, Staff Development 
days, and any other non-attendance days. If your school uses scheduling 
cycles and period rotation, the days of the cycle are assigned to dates on 
the calendar.
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Attendance Days View

Significant Periods View

Significant Periods MUST be set if your school is taking period 
attendance. This allows you to capture that period for the Official 
Attendance Period. This process is mandatory for state reporting.
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Attendance Setup Menu Options

Setting Up the Attendance Calendar

You should set up the Attendance Calendar at the start of each school 
year, before school begins. The only dates you need to enter are the 
beginning and ending dates; the SASIxp educational software enters the 
rest.

The Attendance Aggregation atom will be used for the 400 records and 
principal’s/superintendent’s reports

Menu Option Description

Change Calendar Enables you to renumber an Attendance 
Calendar for the next school year or before 
the current year begins. Because 
renumbering a calendar removes existing 
tags for non-attendance days and can affect 
existing data, this option should not be used 
after users begin entering attendance data 
for the current school year. When you select 
Change Calendar, the system displays the 
following message:

WARNING: All dates will be
changed! This change WILL affect
attendance files. Are you sure?

Click OK to proceed or Cancel to cancel. The 
system displays another message prompting 
you to enter the beginning and ending dates 
of the school year. When you click OK, the 
program fills out the calendar.

Calendar Report Prints an Attendance Calendar Report 
showing all the dates in a school’s 
Attendance Calendar; non-attendance dates 
are identified with the same tags you entered 
in the Calendar itself. Columns are for month 
number, week number, and each day of the 
school week.
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Once you enter these dates, you can identify non-attendance days for any 
tracks being used by your school (these can differ for each one). You can 
also select a bell schedule for each track, if your school is using bell 
schedules. First, however, you need to define these schedules in the Bell 
Schedule tab.

If your school uses period rotation, you set up the rotation using the 
Attendance Calendar page. Before you can do this, you must have defined 
the rotation in the Rotation Definition atom.

Setting Up an Attendance Calendar

1. Open the Attendance Setup atom. The Calendar form displays. If the 
form is blank, a message appears prompting you to enter the 
beginning and ending dates of the school year.

2. Enter the complete beginning and ending dates in the fields provided. 
Click OK. After a pause, the system fills in all fields under the date 
columns. If you enter a beginning or end date that falls in the middle of 
a week, the program adjusts the calendar to begin with the Monday 
prior to your beginning date or to end with the Friday (or Saturday) 
after your end date.

3. Specify non-attendance dates for the current school year or track. 
Click the non-attendance date fields in the track columns to select the 
appropriate code from pop-up list of non-attendance codes. Leave 
fields blank for attendance days.

! If the Traditional (no tracks) track type is selected in the School 
atom, track columns are labeled with T.

! If the Alpha track type is selected in the School atom, track 
columns are labeled with A for the first track. The label changes 
when a different track is chosen from the Track Selection box 
above the Calendar matrix.

! If the numeric track type is selected in the School atom, track 
columns are labeled with 1 for the first track. The label changes 
when a different track is chosen from the Track Selection box 
above the Calendar matrix.

4. If your school uses period rotation, click the “R” field for the first date in 
the calendar and select a day code from the pop-up list. The day codes 
are defined in the Rotation Definition atom. For example if your day 
codes are A – E, and you want the first calendar day to be an “A” day, 
select A in the field for the first day of the year. A dialog box displays 
with the following message.
Do you want to rotate the calendar to the end of the
year?
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5. You have two options:

! Click OK to create a rotating calendar for the entire school year 
starting at the date you just selected. The calendar is readjusted 
forward from that day.

! Click Cancel to put the day code in the field you just selected 
without rotating the schedule for the entire year. Use this option 
when you want to change only one day of the rotation without 
affecting the rest of the year. Specify the bell schedule to be used 
for each date in the school year or current track. Click fields for 
those dates in B columns and use the pop-up list of bell schedules. 
Skip this step if you are not using bell schedules.

6. If you are using more than one track, select each additional track from 
the Track Selection box above the Calendar matrix and repeat steps 3 
and 4 to define non-attendance days and bell schedules for each track.

7. If your school identifies certain periods each day as significant periods, 
toggle the calendar view to the Significant Period view. You can then 
click the Per field to specify the significant period from the pop-up list of 
periods. Once significant periods have been set, toggle the calendar 
view again to the Attendance Days view.

8. Once you define non-attendance days and bell schedules for all tracks, 
the Attendance Calendar is complete. Click Save to save all new 
entries.

Changing the Attendance Calendar

1. Open the Attendance Setup atom.

2. Select the Change Calendar option from the Attendance Setup menu. 
The system displays the following message.
WARNING: All dates will be changed! This change WILL
affect attendance files. Are you sure?

3. Click OK to proceed (click Cancel to cancel). Another message 
appears prompting you to enter the beginning and ending dates of the 
school year.

4. Enter complete beginning and ending dates in the fields provided and 
click OK (click Cancel to cancel changing dates). After a brief pause, 
the SASIxp educational software fills in all fields under date columns 
and removes any data entered in track columns. If you enter a 
beginning or end date that falls in the middle of a week, the program 
adjusts the calendar to begin with the Monday prior to your start date 
or to end with the Friday (or Saturday) after your end date.
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5. Specify new non-attendance dates for the school year or current track. 
Use the pop-up list in those date fields in track columns. Leave fields 
blank for attendance days.

6. Change the bell schedule used for each date of the school year or 
current track, as needed. Click fields for those dates in B columns and 
use the pop-up list of bell schedules. If you are not using bell 
schedules, go on to the next step.

7. If you are using more than one track, select each additional track from 
the Track Selection box above the Calendar matrix. Repeat steps 3 
and 4 to define non-attendance days and bell schedules for each track. 
You can select tracks one at a time or display all at once (see next 
section).

8. If your school identifies certain periods each day as significant periods, 
toggle the calendar view to the Significant Period view. You can then 
click the Per field to specify the significant period from the pop-up list of 
periods. Toggle the calendar view again to the Attendance Days view.

9. Once you define non-attendance days and bell schedules for all tracks, 
the new Attendance Calendar is complete. Click Save to save all new 
entries.

Performing a Mass Change

1. If you are working by column, clicking the heading for one bell 
schedule or track column, or holding down the Shift key and clicking 
several headings highlights everything in the selected column enabling 
you to make mass changes to the selected column. If you are working 
by row, clicking the week number for one week or holding down the 
Shift key and clicking several week numbers does the same thing. All 
selected columns or rows are highlighted.

2. Click any highlighted bell schedule field to select a bell schedule or 
click any highlighted track field to select a non-attendance day tag.

3. Click the Week heading to clear highlighting from all selected columns 
or rows.

4. Click Save to save all new entries (click Undo to remove all new 
entries). If the confirm change option is selected in the current School 
or User record, the system displays a dialog box.

A warning message advises that you are about to mass change all 
selected dates. Click OK to continue. Bell schedules or tags in the 
highlighted columns or rows are automatically entered or changed.
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5. Click OK to confirm that you want to save all changes.

Deleting a Week

The Delete Week option from the Data menu allows you to delete one or 
more weeks so they are no longer displayed in Attendance atom or on 
Attendance scanner sheets.

Although dates in deleted weeks do not display in the Attendance screen, 
they still display in the Attendance Calendar in the Attendance Setup 
atom; track fields for those dates are tagged with D (for delete). 

Deleting Weeks

1. Click the week number for one week or hold down the Shift key and 
click week numbers for several. All selected rows are highlighted.

2. Select Delete Week from the Data menu. Track fields for dates in the 
selected week or weeks are tagged with D (for delete).

3. Click the Week heading to clear highlighting from all selected rows.

4. Click Save to save all new entries.

Calendar Tab Fields

Field Description

Calendar View You can toggle between the Attendance 
Calendar view and the Significant Period 
view. In the significant period view, you can 
identify a significant period for each day in 
the attendance calendar from a pop-up list of 
periods.

Week The system assigns a number for each week 
in the Attendance Calendar. This also 
doubles as the line number for each row.
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Day of Week The sub-columns for Date, Bell Schedule, 
Rotation and Track. There is a column for 
each day of the school week (Monday 
through Friday). If Meet on Saturday is 
selected in the School atom, a column for 
Saturday is also included.

Date The date for each day in the Attendance 
Calendar. Dates fall in the appropriate Day of 
Week column and are entered automatically 
when you set up the calendar. There is a 
column for each day of the school week.

B (for Bell) The bell schedule for each day in the 
Attendance Calendar.

Rotation Code Code for the rotation day that has been 
assigned to this day. Select from the pop-up 
list that is determined by the day codes that 
were set up in the Rotation Definition atom. 
You can change the day code for one day 
only, or rotate the entire calendar forward 
from the day you select. This column only 
displays if your school uses scheduling 
cycles.

Per (Period) In the Significant Period view, you can 
identify a significant period for each day in 
the attendance calendar using the pop-up list 
of periods.

Field Description
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Track Columns Identifies attendance and non-attendance 
days for the track displayed in the Track 
Selection box. Attendance days are 
designated with a blank. Non-attendance 
days are identified with a tag selected from 
the pop-up list that can be accessed from 
fields in Track columns. How these columns 
are labeled depends on the track type 
selected in the School atom. For Traditional 
(no tracks), these columns are labeled with T. 
For Alpha, they are labeled with a track letter. 
For Numeric, they are labeled with a track 
number. There is a track column for each day 
of the school week.

Track Selection Enables you to select the track to work with 
or display in all track columns in the Calendar 
matrix (it only appears if you entered a 
number from in the Tracks field in the School 
atom). To display a specific track calendar, 
use the pop-up list to select the appropriate 
track.

Non-Attendance Day 
Codes

Display under the matrix to show you what’s 
represented by any non-attendance day 
codes in track columns.

Field Description
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Report Periods Tab

Set up any Attendance Reporting Periods the school is using in the 
Reporting Periods tab. These reporting periods are used for attendance 
reporting.

Setting Up Reporting Periods

Once an Attendance Calendar has been set up, you can define 
attendance reporting periods in the Reporting Periods tab of the 
Attendance Setup atom. These can vary for each track used by your 
school. 

The attendance program automatically defines 4-week attendance 
periods. 

The dates you enter identifying the beginning and end of a reporting period 
are validated against the current Attendance Calendar. If you enter an 
invalid date, the system displays a message, and you will need to re-enter 
the date before you can continue.

This screen can be left blank if your school uses 4-week reporting 
periods. However, if your reporting periods are different, enter the 
correct dates for each period.
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Reporting Periods Fields

Field Description

Track Selection Enables you to select the track to work with in 
both matrices. This field is visible only if your 
school is set up as a track school in School 
atom).

Left Matrix and Right 
Matrix

Each row is devoted to one attendance 
reporting period. The Period column contains 
a system-assigned number for each reporting 
period. The Start Date column contains the 
starting date for each reporting period list. 
The Stop Date column contains the stop date 
for each reporting period listed. Start and 
stop dates are validated against the 
Attendance Calendar.



Using the Attendance Setup Atom

124   Copyright © 2004 Pearson School Systems

Bell Schedule Tab

If your school uses Bell Schedules, you can establish up to nine different 
schedules on the Bell Schedules tab. This must be done before you assign 
Bell Schedules on the Attendance Calendar.

The times on the Bell Schedules tab print on the Class Schedules report 
and Student Schedules report. If the Minutes Per Hour and Minutes Per 
Pass fields are not filled in on the report interface for the Hourly 
Attendance Report or Hourly Attendance Audit, the information on the Bell 
Schedules tab will be used.
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Bell Schedule Fields

Field Description

Bell Schedule Selection 
Box

Enables you to select the bell schedule to 
work with from the bell schedule matrix. You 
can modify the program-assigned titles (Bell 
Schedule 1, Bell Schedule 2, etc.) to make 
them more descriptive and meaningful.

Period A number for each period in the school’s 
schedule. A maximum of 12 periods can be 
set up in the School atom.

Start Time The starting hour and minute for each period 
in a schedule. If you enter just digits, the 
program automatically inserts a colon and 
adds AM when you exit the field. If a time falls 
in the afternoon, you will need to enter PM 
yourself.

Stop Time The stopping hour and minute for each 
period in a schedule. If you enter just digits, 
the program automatically inserts a colon and 
adds AM when you exit the field. If a time falls 
in the afternoon, you must type PM yourself.

Total The total number of minutes in each period. 
The system calculates this after you exit the 
Stop Time field. A total is not calculated if the 
value for either the start or stop time is zero.

Passing Time The time allowed between periods. If you 
enter passing times. Unlike Totals, this is not 
calculated by the system, so you must adjust 
Start Time.
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Absence Reasons Tab

The Absence Reasons tab is where you create the codes and basic 
information about the kinds of absences your school uses.

Setting Up Absence Reason Codes

Absence Reasons Codes are needed for state funding.

You can define up to 50 absence reasons to be used in the Attendance 
atoms and most attendance reports from the Absence Reason tab. All 
reasons you define here are included in the pop-up list that displays in 
Attendance atoms (including Daily Attendance, Period Attendance, Class 
Attendance, Mass Change). They are also used in attendance reports and 
letters, and as verification reasons for attendance scanner sheets.

You can add or delete reasons using options on the Data menu. Keep in 
mind, however, that reasons should not be deleted after users begin 
entering attendance data.

Adding Absence Reasons

1. Open the Attendance Setup atom. Click the Absence Reasons tab.

2. Select the Add Reason option from the Data menu. A line number 
displays in the Num field of the first row available. The entire row is 
highlighted.
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3. Fill in the appropriate fields.

4. Click Save to save all new entries, then click OK to confirm that you 
want to save the reason just added.

Deleting Absence Reasons

1. Open the Attendance Setup atom and click the Absence Reasons tab.

2. Click the line number of the reason you wish to delete.

3. Select the Delete option from the Edit menu. The row for the reason is 
removed and rows below it are renumbered and repositioned to fill in 
the gap.

4. Click Save to delete the reason from the absence reason list.

5. Click OK to confirm that you want to delete the reason.

Absence Reasons Fields

Field Description

Num The line number for each row. You can click 
a line number to select a row and highlight it.

Cd The 1-character code for each absence 
reason defined here by the school. Codes 
display in parentheses on pop-up lists in 
attendance-related atoms and are the 
bubbles on attendance verification scan 
forms.

Title The name for each absence reason used by 
the school. Titles can be up to 10 characters 
in length and display on pop-up lists in 
attendance-related atoms.

Abbr The abbreviation for each absence reason 
used by the school. Abbreviation scan be up 
to 3 characters long and display in fields in 
attendance-related atoms when you select 
reasons from the pop-up list.
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Type The type for each absence reason; you can 
view absence totals by reason type in the 
Daily Attendance and Period Absence atoms. 
Program-defined reason types include:

! Unverified
! Not Excused
! Excused
! School Activity
! Excused Tardy
! Unexcused Tardy
! Non Enrolled
! Positive

You can classify multiple reason codes under 
one type. For example, Illness, Lice, and 
Other might qualify as Excused absences.

Note: Because unverified absences requires 
follow-up, Unverified should be the 
only absence reason classified under 
the Unverified type.

You can select reason types from the pop-up 
list accessed by clicking fields in the Type 
column. Program-defined absence reason 
types are defined in the ATR table of the 
Tables atom.

Receives Apportion Indicates that an absence reason meets state 
criteria for attendance funding; the correct 
setting of indicators in this column is very 
important in calculating totals for attendance 
reports. You can toggle between a choice of 
Yes (does qualify for funding) or blank (does 
not qualify for funding) by clicking fields in the 
column.

Field Description
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Other Options Tab

The Other Options tab is where you perform miscellaneous attendance 
setup, such as defining report groups, selecting the half-day attendance 
option, specifying when attendance should be taken, and more.

The features included in the Other Options tab vary according to whether 
Daily or Period is selected as the Attendance Type in the School atom. For 
period attendance schools, another variable that affects which features are 
included is how many periods are set up.

Included in Dialer Indicates that the absence reason is used by 
the phone dialer program. Typically, a school 
would make calls regarding unverified or 
unexcused absences. You can toggle 
between a choice of Yes (home should be 
called) or blank (the reason does not merit a 
call) by clicking fields in the column.

Included in Letters Indicates that the absence reason is used by 
the attendance letters program. You can 
toggle between a choice of Yes (letter should 
be sent) or blank (the reason does not merit a 
letter) by clicking fields in the column.

Included in Reports Indicates that the selected absence reason 
should be included in attendance reports. 
You can toggle between a choice of Yes 
(reason should be included) or blank (reason 
should not be included) by clicking fields in 
the column.

Absence Group Select from a pop-up list the absence group 
to which the absence reason belongs. You 
set up the values for the Absence Group 
table (ATG) using the Tables Definition atom. 

Field Description
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Other Options Tab Fields

Field Description

Report Groups Table Enables you to specify which group each 
grade level should be included in for subtotal 
purposes when you run Monthly Attendance 
Summary reports (available from the Daily 
Attendance or Period Attendance atom). The 
table displays a field for each grade level 
defined in the School atom; each field 
contains a pop-up list of report groups that 
are defined in the ATC Table in the Tables 
atom.

Instructional Days State-specific number of instructional days 
(both students and teachers are present) for 
each grade level in the matrix.

Non-Instructional Days State-specific number of non-instructional 
days (teachers are present; students are not) 
for each grade level in the matrix.

Day Length in Minutes The number of minutes in the school day for 
each grade. Use this field if your school is not 
using bell schedules, but still needs to specify 
the length of the school day.
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Period Attendance Schools

Period Attendance Fields
:

Field Description

Periods of day when 
Attendance is taken

Enables you to specify the periods when 
attendance should be taken if the school is 
using 14 periods or more. If a school uses 
fewer than 14 periods, the SASIxp 
educational software assumes attendance is 
taken every period. This table is only shown if 
Period is selected as the attendance type in 
the School atom and the total number of 
periods defined is 14 or more.

Attendance by 
Significant Period

Enables you to designate a significant period 
for each day in the attendance calendar. If 
you select this option, the significant period 
attendance reason displays and prints in the 
all day code on all forms and reports.
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Daily Attendance Schools

Daily Attendance Fields

Field Description

School is Using Half Day 
Attendance

Activates features that enable a daily 
attendance school to take half-day 
attendance. When this option is selected, 
pairs of AM and PM columns display in all 
forms in the Daily Attendance and Class 
Attendance atoms. In addition, a field labeled 
Select part of day to change displays in the 
Mass Change tab. This option is only visible if 
Daily is selected as the attendance type in 
the School atom.
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Scanner Options Tab

The Scanner Options tab enables you to set up the SASIxp educational 
software to work with the scanner and forms that your school uses for 
attendance.

For easy setup, all the fields in this tab contain pop-up lists of values 
(these are defined in the Tables atom). To select a value, click the down 
arrow in a field to display the list of values.

Scanner Options Fields

Field Description

Scanner Form The type of scanner form your school is 
using. Select this from a pop-up list. (SCA 
table)

Scanner Verification 
Form

The type of scanner verification form your 
school is using. Select this from a pop-up list. 
(SCV table)
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Verification Sheet 
Reason(s)

Any absence reasons to be verified in the two 
additional columns available on 48 channel 
verification forms. These fields apply only to 
48-channel forms. Select reasons from the 
pop-up list defined in the Absence Reasons 
tab of Attendance Setup.

Sheet File Type Identifies whether your school is using a two-
week sheet file or a one-week sheet file.

48-channel forms – The two-week sheet has 
two bubbles for each day; the one-week 
sheet has three bubbles for each day.

27-channel forms – This tab can be used to 
record absences and tardies for one week, or 
to record absences (only) for two weeks. 
When you are using the tab to cover two 
weeks of attendance, select Two Week 
Sheet File (not keeping tardies).

Scanner The scanner your school is using. You can 
select this from a school-defined pop-up list. 
(SCN table)

Port The port your scanner is attached to. You can 
select this from a school-defined pop-up list. 
(PRT table)

Print Mark Darkness Specifies the degree of darkness of printed 
mark (slug) on 48-channel scanner sheets 
that are read successfully. The setting varies 
depending upon how dark your printer 
normally prints. Suggested starting point is 
10. (PMD table)

Pencil Mark Darkness Specifies the degree of darkness of pencil 
marks on 48-channel scanner sheets that are 
read successfully. This varies depending 
upon how darkly each attendance bubble is 
colored in. If your scanner seems to pick up 
too many stray pencil marks, this number can 
be increased. Suggested starting point is 7. 
(PMD table)

Field Description
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Pencil Mark Difference Specifies the acceptable difference in 
darkness between two pencil marks in the 
same selection group. For example, if the 
valid mark has a darkness of 5 and the 
erasure has a darkness of 3, the program 
disregards the erasure when the difference 
setting is at 2 or lower. It would not disregard 
the erasure if the difference setting were at 3. 
Instead, an error would be reported. If your 
scanner is not differentiating between the 
marks and the erasures, this number can be 
increased. Suggested starting point is 4. 
(PMD table)

Absence Reasons Enables you to choose the absence reason 
that is recorded for each of the two (or three) 
bubbles on your attendance sheet. Select 
from the pop-up list of absence reasons. The 
default is Present.

Field Description
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More About Scanning and Absence Reasons

If you do not change the reasons in these fields, the following defaults 
apply to the bubbles on your attendance sheets:

Sheet Reasons

One-Week Sheet A – Absent. This marking is recorded on the 
student’s attendance record as an unverified 
absence until it is changed to a verified 
absence. Students with any unverified 
absences continue to appear on the 
verification list until the absences are 
changed to some other type. Absence types 
can be changed by scanning the verification 
list or by entering the information directly on 
the screen.

T – Tardy. This marking is for an excused 
tardy. It is recorded as a tardy on the 
student’s attendance record.

U – Unexcused Tardy. This mark is 
recorded as an unexcused tardy on the 
student attendance record.

Two-Week Sheet File A – Absent. This marking is recorded in the 
attendance files as an unverified absence 
until a note is received from the parents and it 
is changed to a verified absence by the 
attendance office.

T – Tardy. This marking is for an excused 
tardy. It is recorded as a tardy on the 
student’s attendance record.

The ability to define the meanings of the 
bubbles on your attendance sheets gives you 
the flexibility to take positive attendance with 
scan sheets.
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Advanced Tab

The Advanced Tab enables you to set up several specialized and 
advanced SASIxp educational software features that may impact the way 
many other atoms function.

Advanced Fields

Fields Descriptions

Use Attachments Activates attendance attachments in the 
Period or Daily Attendance atoms.

Attachments are additional attendance data 
you can enter for each student. 

Time 1 Heading A description of Time 1, used for reports.

Time 2 Heading A description of Time 2, used for reports.

Use Time As Enables you to choose between minutes or 
time as the formatting used for the Time 1 
and Time 2 headings

Use Section Attendance Select this check box if your school uses 
section attendance.
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Count Block Period 
Sections As One 
Absence

Select this check box if you want only a 
single absence recorded for a block class 
that lasts more than one period.

Count absent if any 
period absent

Select this check box if you want to count the 
student absent from the entire block if they 
miss any period within the block.

Count absence if all 
periods absent

Select this check box if you want to records 
an absence for a student only if they are 
absent for all periods in the block.

Fields Descriptions
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The Enrollment Validation Definition Atom enables you to validate student 
data during the student enrollment process using validation rules defined 
by your school or district. Data that is validated includes enter and leave 
codes along with enter and leave dates.

Use the Enrollment Validation Def Atom when you first set up the SASIxp 
software to define the enter and leave code validation rules that apply to 
both enter codes/groups and leave codes/groups. You can modify this list 
at any time.

Before you can set up enrollment validation definitions, you must be sure 
that the system contains correct settings for the Tables Definition, School, 
and Attendance Setup atoms.

Enrollment Validation Definition Screen
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Adding and Deleting Enrollment Validation Rules

Adding Enrollment Validation Rules

1. Open the Enrollment Val Def atom.

2. From the Data menu, select Add Rule.

3. In the Ent Cd field, select an enter code to be defined. You can assign 
enrollment validation rules to various combinations of enter codes, 
enter code groups, leave codes, and leave code groups.

4. Where applicable, in each of the other fields (Ent Gp, Lve Cd, and Lve 
Gp), select a code to be defined.

5. In the Validation Rule field, select a validation rule to apply to the 
selected code or combination of codes.

6. Repeat Steps 3 through 5 for each validation rule to be defined. There 
is no limit to the number of rules you can define.

7. Click Save to save your entries.

Deleting Enrollment Validation Rules

1. Open the Enrollment Val Def atom.

2. From the Data menu, select Delete Rule.

3. Click Save to save your entries, then click Close to close the atom.

Pre-defined EDR Table Rules

The following validation rules are pre-defined in the EDR table:

! Enter date valid calendar date.
! Enter date within current year.
! No enter date/code in current year.
! Enter date/code exist in current year.
! Leave date valid calendar date.
! Leave date within current year.
! No leave date/code in current year.

The Enrollment Validation rules are predefined in the EDR table by 
Pearson School Systems so that the rules can be generally applied to 
many specific situations.
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! Leave date/code exist in current year.
! Enter/leave date/code exist in current year.
! No enter/leave date/code in current year.
! Student not previously enrolled in district.
! Not previously enrolled if last leave code.
! Current school same as last enrolled.
! Current school not same as last enrolled.
! Must be last leave code.
! Cannot be last leave code.
! Must be last enter code.
! Cannot be last enter code.
! Must be concurrent enrollment student.
! Cannot be concurrent enrollment student.

Enrollment Validation Definition Fields

Field Description

Ln Line number for each row. You can click a 
line number to select a row and highlight it.

Ent Cd Enter code indicating the circumstances 
under which a student enrolls at your school.

Ent Gp Enter code group indicating the 
circumstances under which a group of 
students enrolls at your school.

Lve Cd Leave code indicating the circumstances 
under which a student leaves your school.

Lve Gp Leave code group indicating the 
circumstances under which a group of 
students leaves your school.

Validation Rule Rule used by each enter/leave code and 
enter/leave code group to validate incoming 
student enrollment information. 
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Use the Street atom (in the Non-student Info folder) to maintain a list of 
street addresses in the school enrollment area. You then use these 
addresses during enrollment to determine whether a student resides within 
the boundaries for the school or the district.

If a student’s residence street address is within the boundaries, the 
SASIxp software automatically completes the residence city, state, zip 
code, grid code, and morning and evening bus stop information in the 
Student atom. If a student’s residence street address isn’t within the 
boundaries, a dialog box displays requesting an attendance permit code 
and permit date.

The SASIxp software accepts fractional addresses, such as 1055 ½ E. 
Main. To enter this fractional address, type 1055 1/2 (including the slash).

You can also use the Street atom to record morning and evening bus stop 
information for the elementary, middle, and high schools associated with 
the street.

Options Available in the Street Atom

A single street can have multiple entries in the Street file. Different parts 
of a street can be in the residence area for different schools, or they can 
have different directions (for example, W. Chatham Place and E. 
Chatham Place), bus information, or grid codes.

Option Description

Find Address Use this option to maintain the Street file or to 
quickly find street or bus directory 
information. This option is useful during walk-
in enrollment.

Import Streets Enables you to append or replace the current 
Street file.

Validate Addresses Validates all addresses in the Street file, or to 
assign a new permit code to all invalid 
addresses.
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Street Screen

Working With Street Validation

For street validation to operate properly, you should perform the following 
steps.

Setting Up Street Validation

1. Enter custom permit codes in the ATP (Attendance Permit Codes) 
table using the Tables Definition atom. This table includes several pre-
defined entries. You can add at least one custom permit code to use 
during batch validation to mark invalid addresses (addresses that do 
not match the Street file). Then you can use the Query atom to create 

Copy Addresses Saves multiple years’ records in the Street 
file by copying street records from blank year 
to desired years.

Delete Addresses Use this option after you copy street records 
from blank year to the desired years. Delete 
the blank year records.

Option Description
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a list of addresses that need to be corrected. You can also add any 
other permit codes required by your school (up to a maximum of nine 
codes).

2. Run the batch validation process. This process validates all student 
address data against the Street file. During this process, the SASIxp 
software copies the data currently in the mailing address fields into the 
residence address fields (you can later change one or both of these 
addresses as necessary). It also tags any addresses that could not be 
validated with the permit code you defined in Step 1.

Once you have set up your street validation, you can:

! Import street addresses into the Street atom from space- or comma-
delimited files.

! Add and delete streets.
! Validate all student residence addresses currently stored in the 

SASIxp software against the data in the Street file.

Importing Street Addresses

1. Open the Street atom.

2. From the Street menu, select Import Streets.

3. To append the new data to the existing Street file, select the Append to 
existing Street File option. To replace the existing Street file (and erase 
all previous entries), select the Replace existing Street File option.

4. Click Select Import File to identify the file you want to import. In the 
resulting dialog box, locate and select the correct file, then click Open. 
The selected file displays in the Import File field.

5. Click Import to import the data, or click Close to close the Import 
Streets dialog box without importing.

Adding a Street

1. Open the Street atom.

2. From the Data menu, select the Add Street option.

3. Complete the fields in the Street atom. You must enter data in the 
Street Name, Lo House, and Hi House fields.

The permit code is subject to the restrictions you set in the Security 
atom. You should set the security options so that students from 
outside the area cannot enroll without a valid permit code.
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4. Click Save to save the new street, or click Undo to close the Atom 
without saving.

Deleting a Street

1. Open the Street atom from anywhere on the Desktop, and select the 
street you want to delete.

2. From the Data menu, select Delete Street.

3. Click Close to close the atom.

Batch Validating Street Addresses

1. Open the Street atom.

2. From the Street menu, select the Validate Addresses option. the 
SASIxp software asks for a permit code and permit date to set for all 
invalid residence addresses.

3. In the Permit Code field, select the permit code you defined for invalid 
addresses.

4. In the Permit Date field, type the permit date.

5. Click Validate to begin the address validation, or click Close to close 
the Validate Addresses dialog box.

6. Click Close.

Street Fields

If you do not want to replace existing permit codes and dates, select 
the Honor existing permit codes option.

Field Description

Year Allows simultaneously maintaining and 
using different sets of streets in the street 
file for different years.

Old street records with a blank year are 
regarded as current year records by 
address validation.

Street Name Name of the street.
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Lo House Lowest house number on the street.

Hi House Highest house number on the street.

House Inc Increment at which the house numbers are 
increased.

H Type House number type. Choices are:

! E – Even house numbers
! O – Odd house numbers
! B – No restriction

St Dir Street direction. Choices are E, N, NE, NW, 
S, SE, SW, and W.

St Type Street type. (STT table)

City City in which the street is located.

State State in which the street is located.

Zip Code Zip code for the street.

District Indicates whether the street is in or out of 
the district.

Grid Code Geographic grid code.

Elem Number of the elementary school that 
serves this street.

Midl Number of the middle school that serves this 
street.

High Number of the high school that serves this 
street.

ES Bus 1 Number of the morning school bus that 
picks up elementary school students who 
live on this street.

Elementary Bus Stop 1 Description of the morning elementary 
school bus stop.

Field Description
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ES Bus 2 Number of the evening school bus that 
returns elementary school students who live 
on this street.

Elementary Bus Stop 2 Description of the evening elementary 
school bus stop.

MS Bus 1 Number of the morning school bus that 
picks up middle school students who live on 
this street.

Middle School Bus Stop 1 Description of the morning middle school 
bus stop.

MS Bus 2 Number of the evening school bus that 
returns middle school students who live on 
this street.

Middle School Bus Stop 2 Description of the evening middle school 
bus stop.

HS Bus 1 Number of the morning school bus that 
picks up high school students who live on 
this street.

High School Bus Stop 1 Description of the morning high school bus 
stop.

HS Bus 2 Number of the evening school bus that 
returns high school students who live on this 
street.

High School Bus Stop 2 Description of the evening high school bus 
stop.

Field Description
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Use the Enrollment Proc Def atom (in the System Setup folder) to set up 
the list of Fast Access atoms for use in the Enrollment atom. Fast Access 
atoms are those atoms that the school has deemed essential to enrolling 
students and maintaining student data. Including them in the Enrollment 
atom provides users with a complete list of these atoms and a fast, 
convenient way to access them. (Open Fast Access Atoms from the 
Enrollment atom using link arrows.)

You can select up to 24 Fast Access atoms from the list contained in the 
Enrollment Proc Definitions atom and organize them in any order you 
want. You can include utility atoms (such as Query or Phone Numbers) as 
well as atoms requiring data entry.

Designating an atom as a Fast Access Atom does not remove it from the 
desktop. Users can still open them from the desktop or from aliases in 
toolbars.
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Enrollment Proc Def Matrix

The Enrollment Proc Def atom contains one matrix. This lists the SASIxp 
educational software atoms and their related file codes. Each row is 
devoted to one atom.

Working with Enrollment Process Definition

Including Atoms in Fast Access

1. Open the Enrollment Proc Def atom.

2. Click in the Step # column and type a number to indicate the atom’s 
relative position in the list of Fast Access atoms. Numbers should 
begin with 100 and advance by 10s (for example, 100, 110, 120, 130).

3. Click the Include column to designate the atom as a Fast Access atom. 
If you click again to clear the Yes checkbox, the atom remains 
numbered, but does display in the Enrollment atom.

4. Repeat Steps 2 and 3 for each atom you want to designate as a Fast 
Access atom.

5. Enter the pane number of the atom that you want the Fast Access link 
arrow to start. For example, pane 2 of the Health atom contains the 
Immunization screen. During enrollment, you would be entering the 
student’s immunization information.



Copyright © 2004 Pearson School Systems  151

Using the Enrollment Process Definition 
Atom

6. Click Save to save your entries or changes. They are reflected in the 
Enrollment atom and in the Atom ID atom. (Click Undo to clear new 
entries or revert to previous entries).

7. Click OK to confirm that you want to save changes.

To see the newly-defined list of Fast Access atoms, open the Enrollment 
atom. If the Enrollment atom is open while you work in the Enrollment 
Definition atom, you will need to close the Enrollment atom and start it 
again to clear any existing setup from the screen and display the new one.
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Enrollment Proc Def Fields

Field Description

Ln Line number for each row.

Atom Description Description of each atom listed.

File Code File name for each atom listed.

Atom # Number of the atom listed.

Step # Contains numbers indicating each atom’s 
position on the list of Fast Access atoms. As 
you assign numbers, do not expect to see the 
atom order change in the Process Step 
column. The order determined by your 
numbers is only reflected in the Fast Access 
list in the Enrollment atom.

Numbers should begin with 100, advance by 
10s (for example, 100, 110, 120, 130) and 
must be three digits (for example, 085). 
Numbering this way enables you to insert 
atoms later without having to reorganize the 
list. The Enrollment atom fast access section 
has room for twenty-four Fast Access atoms.

Include Indicates whether an atom is to be included 
as a Fast Access atom in the Enrollment 
atom. You can toggle between a choice of 
Yes (include) or blank (do not include) by 
clicking fields in the column.

Pane # If you want Fast Access to take you directly 
to a second or third screen of an atom, enter 
the pane number. For example, immunization 
records are on pane 2 of the Health atom.
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You can set up the Student data entry screen to contain the fields that you 
use to enter student information, in the order that works best for your 
school. Use the Student Entry Definition atom (in the System Setup folder) 
to define which fields appear on the Student data entry screen and the 
order in which they are listed. You can change these settings at any time.

Student Entry Definition Screen

The data entry screen that you define can have fields from a number of 
student-related files in the pop-up list. The fields within the files are also 
selected from a pop-up list. You can change the order of the fields or 
delete fields from the definition of the data entry screen so that they do not 
display.

Do not define any fields that are used when enrolling a student on the 
Student Data Entry Definition screen (for example, Student’s last name, 
permanent ID, etc.)
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Working with Data Entry Definitions

Use the following exercises to practice techniques for working with data 
entry definitions.

Creating a Data Entry Definition

1. Open the Data Entry Definition atom.

2. Select Add Definition from the Data menu or press Alt-A (Windows) or 
Cmd-A (Macintosh).

3. The cursor should be in the Record ID field. Type a unique ID 
(maximum 2 characters) for the data entry screen you are creating.

4. In the Description field, type a description for the data entry screen you 
are creating, up to 30 characters.

5. Click Add Line. A new line number is added to the matrix and the File 
Code field is highlighted on the new, blank line.

6. Click in the File Code field in the new line and select a file from the 
pop-up list. You should select the file that contains the field you want to 
add to the data entry screen. You can choose from the pop-up list of 
files.

7. In the Field Name field, select a field from the pop-up list. The fields 
that display in the pop-up list are the fields contained in the file you 
selected in Step 6. When you select a field, the description displays 
automatically in the description field.

8. If this file has more than one record per student (such as Parent/
Guardian file), click the Record ID field to select a record ID from the 
pop-up list. For example, if you are recording both mother’s and 
father’s names, you need to differentiate between them. For the 
mother’s name, select “First Name” in the Field Name field and select 
“01—Mother” in the Record ID field.

Because the student’s name, grade, and gender display at the top of 
the Student Data Entry screen, do not include these mandatory fields 
from the enrollment atom on the data entry screen (student first and 
last name, grade, gender, student ID, enter date, enter code). If one 
of these fields is included in the Student Data Entry screen, any 
information that is entered in the Student Data Entry screen replaces 
the original information.
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9. If you want to display a label that is different from the text that appears 
in the Field Name field, click the Field Label field and enter a more 
descriptive label. For example, “Mother’s First Name.”

10. Continue to add fields by clicking the Add Line button. The File Code 
that was used on the previous line is automatically entered on the new 
line. If you want to use the file name that displays, add the next field as 
described in Steps 7 through 9.

11. When the list of fields is complete, click Save to save the Data Entry 
screen definition.

Deleting Lines from the Definition Screen

1. With the Data Entry Definition tab displayed, click the line number of 
the line you want to delete. The entire row is highlighted.

2. Click Del Line at the bottom of the screen. The line that was 
highlighted is deleted and the remaining rows are moved to fill in the 
gap.

Changing the Order of the Fields

1. Open the Data Entry Definition atom.

2. Select the data entry definition that you want to change by clicking the 
forward and back arrows or performing a Find.

3. Move the fields into a different order by using drag and drop on the Ln 
field. Move the highlighted row where you want it and release the 
mouse button. The rows are reordered automatically. 

4. When your changes are complete, click Save. (Click Undo to cancel all 
changes.)

Inactivating a Definition

1. Open the Data Entry Definition atom.

2. Find the definition that you want to make inactive by clicking the 
forward or reverse arrows, or performing a Find.

If you want to select a different File Code, first select a field name 
from the pop-up list in the Field Name field, then return to the File 
Code field and select a different file name from the pop-up list. Add 
the next field as directed in steps 7 through 9.
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3. Select the Inactivate Definition option from the Data menu. The 
definition is made inactive.

4. Reactivate a definition by displaying the definition, then selecting 
Activate Definition from the Data menu.

Deleting a Data Entry Definition

1. Open the Data Entry Definition atom.

2. Find the Definition that you want to delete by clicking the forward or 
reverse arrows, or performing a Find.

3. Select the Delete Definition option from the Data menu. The definition 
(the entire file) is deleted when you let go of the mouse button.

Student Entry Definition Fields

Field Description

Def ID Unique 1- or 2-character (alphanumeric) 
identifier for this data entry screen. You can 
define more than one data entry screen.

Definition Description Name for this data entry screen definition.

Ln Line number assigned by the program. Fields 
that you define in this atom appear in order 
by line number in the Student Data Entry 
atom.

File Code File where each field is found. You select file 
names from a pop-up list.

Field Name Name of the field that you want on the data 
entry screen. This is the label that shows on 
the screen unless you enter some other label 
in the Field Label field.
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Record ID When a file has multiple records per student, 
you can select which record applies by 
choosing the appropriate Record ID from the 
pop-up list. For example, if the field name is 
“first name,” you can define whose first name 
it is (father, mother, guardian, etc.)
If you want to add information to the Parent/
Guardian file (APRN), you must create a last 
name or first name field for the corresponding 
parent. For example, if you want to record the 
mother’s telephone number, you must first 
record the mother’s first or last name.

Field Label Enter a more descriptive label (up to 25 
characters) that you want to use on the data 
entry screen. For example, if you are 
recording names for mother and father, you 
can enter a label that says Mother’s First 
Name and another label for Father’s First 
Name. If you do not enter a field label, the 
Data Entry Screen shows “FirstName.” 
(Taken from the Field Name field).

Description Description of the contents of the field. This 
field is display-only. Look at this field if you 
need a complete description of the contents 
of the field.

Field Description
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Using the Service Program Definition Atom

The Service Program Definition Atom enables you to define student 
service programs and service program levels. You can indicate the grade 
level for the service program and whether the program operates at the 
school (local program) or district-wide.

Service Program Definition Screen

Working with Service Programs

Use the following techniques to add and remove service programs.

Adding a Service Program

1. Open the Service Program Definition atom.

2. From the Data menu, select Add Program.

3. In the Program ID field, enter a four-character code for the service 
program.
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4. In the Program Name field, enter the name of the service program.

5. In the Migr Option field, select a migration option for the service 
program.

6. In the Migr Limit field, select the highest grade that is eligible for the 
service program.

7. In the Local Pgm field, select Y – Yes if the program is only available at 
the local school. Leave this field blank if the program is district-wide.

8. Click Save to save the service program definition. or click Undo to 
close without saving.

Adding Program Levels to the Service Program

1. Open the Service Program Definition atom, and locate the service 
program to which you want to add a level.

2. From the Program Definition menu, select Add Program Level.

3. In the Level Code field, enter the 2-character code for the level.

4. In the Level Description field, enter up to 40 characters to describe the 
program level.

5. Click Save to save the service program definition., or click Undo to 
close without saving.

Removing a Program Level

1. Open the Service Program Definition, and locate the service program 
from which you want to delete a level.

2. Click the Ln number of the service program level you want to delete to 
highlight the line.

3. From the Program Definition menu, select Delete Program Level.

4. Click Save to save the service program definition.

Removing a Service Program

1. Open the Service Program Definition atom and locate the service 
program you want to delete.

2. From the Data menu, select Delete Program Level.

3. Click Save.
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Service Program Definition Fields

Field Description

Program ID Identification code for the service program.

Program Name Name of the service program.

Migr Option The migration option for the service program. 
This is used by the Beginning of Year 
process in the Student Service Program 
atom. Choices include:

! No Migration: A student who participated 
in the service program during the 
previous year is not re-enrolled in the 
program during the Beginning of Year 
process for the following year.

! Migrates at same school only: A student 
who participated in the service program 
during the previous year is re-enrolled in 
the program during the Beginning of Year 
process if: 1) his or her grade level in the 
Student file (ASTU) is less than or equal 
to the grade level in the Migr Limit field 
and 2) the student is enrolled in the same 
school in the previous and current year.

! Always migrates: A student who 
participated in the service program during 
the previous year is re-enrolled in the 
program during the Beginning of Year 
process if his or her grade level in the 
Student file (ASTU) is less than or equal 
to the grade level in the Migr Limit field.

Migr Limit Highest grade level that is eligible to 
participate in the service program.

Local Pgm When selected, indicates that the service 
program is only available at the local school.

Level Code Code identifying the service program level; 
for example, HS for high school.

Level Description Description of the service program level.
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Performing Setup for Discipline

Setting Up Discipline Codes
Use the Discipline Codes atom (in the Discipline folder) to set up the list of 
codes for discipline infractions used in the Discipline atom. The list of 
codes you create in the Discipline Codes atom displays on a pop-up list in 
the Discipline atom. Users can select codes from this list as they add 
incidents in Discipline records.

Discipline Codes Screen

The Discipline Codes atom contains a matrix with one row for each 
infraction.

Adding Codes to the Discipline Codes List

1. Open the Discipline Codes atom.

2. Select the Add Discipline Codes option from the Data menu. A new 
line number displays in the Ln column.
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3. In the Code column, type a numeric code for an infraction; this can be 
from 1-3 characters in length.

4. In the Description column, enter a description for the infraction.

5. In the Demerits column, type the number of demerits for the infraction.

6. In the Security column, type the number of the security levels needed 
to access information on the infraction. Security levels are numbered 0 
through 9, with 9 being the highest.

7. Click time in the Credit column to flag the incident as Yes to define it as 
a credit incident. 

8. Click Save to save the code (click Undo to erase all entries for the 
code).

9. Click OK to confirm that you want to save new entries.

10. Click Close.

Deleting Codes from the Discipline Codes List

1. Open the Discipline Codes. 

2. Click the Ln number for a discipline code to highlight its row.

3. Select the Delete Discipline Codes option from the Data menu. The 
row for the discipline code is removed from the list of Discipline Codes 
in the matrix. If you delete any row but the last, remaining rows are 
renumbered and repositioned to fill in the gap.

4. Click Save to save the change and permanently delete the code from 
the Discipline Codes list (click Undo to restore it).

5. Click OK to confirm the deletion.

6. Click Close.

Discipline Codes Fields

Field Description

Ln The line number for each row.

Code Code for each discipline infraction.
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Description Contains descriptions for the discipline code. 
When users select codes in the Discipline 
atom, the associated descriptions display 
automatically.

Demerits Number of demerits assigned to each code. 
When users select codes in the Discipline 
atom, the associated demerits display 
automatically. Users can modify the demerits 
for an incident, if needed.

Security Security level assigned to each code. A user 
must have this security level or higher to view 
incidents assigned this code. For example, 
setting a security level for a code to 6 means 
that users with a security level of 6 or higher 
can see this incident. Users with a security 
level below 6 cannot see it. Number levels 
from 0–9.

Credit Enables you to give credit against hours that 
need to be worked off for a disciplinary 
action. For example, you may want to create 
a discipline code for attending detention or a 
guidance session reduces the number of 
hours on the student’s discipline record. Click 
in the Credit column to enter Y for Yes. When 
you enter the number of hours for an incident 
that is marked Yes, the system records hours 
as negative numbers and subtracts them 
from the total hours for the student.

Field Description
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Setting Up Conference Codes

To set up the list of codes used in the Conference atom, use the 
Conference Codes atom (in the System Setup folder). You can use this 
atom to create the pop-up list of codes available in the Conference atom. 
In the Conference Codes matrix, you can enter an alphanumeric code and 
description for each type of conference along with a security level. This 
atom is the only place where you can set security levels for conference 
codes.

Conference Codes Matrix

The Conference Codes atom contains a matrix with one row for each 
conference.

Working with Conference Codes

Use these procedures to add and delete conference codes.
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Adding Conference Codes

1. Open the Conference Codes atom.

2. Select Add Conference Codes from the Data menu. A line number for 
the new code displays in the Ln column.

3. In the Code column, type a 1-3 digit code for a conference code.

4. In the Description column, enter a description for the infraction.

5. In the Security column, type the number of the security level needed to 
access information on the infraction, 9 being the highest.

6. Click Save to save the code.

Deleting Codes from the Conference Codes List

1. Open the Conference Codes atom.

2. Click the Ln number for a discipline code to highlight its row.

3. Select Delete Conference Codes from the Data menu. The row for the 
conference code is removed from the list of Conference Codes in the 
matrix. If you delete any row but the last, remaining rows are 
renumbered and repositioned to fill in the gap.

4. Click Save to save the change and permanently delete the code from 
the conference codes list, then click OK to confirm the deletion.

5. Click Close.

Conference Codes Fields

Field Description

Ln Line number for each row.

Code Three-character for each conference code 
that you want to use at your school.

Description Descriptions of each code. When users 
select codes in the Conference atom, 
descriptions display automatically.
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Security The security level assigned to each code. A 
user must have this security level or higher to 
view conferences assigned this code. 
Security levels should be numbered from 0 – 
9 (the same numbers used to indicate user 
security levels). Setting a security level to 6 
means that users with a security level of 6 or 
higher can see this conference. Users with a 
security level below 6 cannot see it.

Field Description
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Setting Up Fee Codes

Use the Fee Codes atom (in the System Setup folder) to create the pop-up 
list of codes available in the Fees atom. In the Fee Codes matrix, you can 
enter a code and description for each student fee (for example, Associated 
Student Body fees or lab fees), along with a fee amount in dollars and a 
fee type. Users select the fee type from a pop-up list of fee types that is set 
up in the Tables Definition atom.

Fee Codes Screen

Using the Fee Codes Atom

You use the Fee Codes atom to maintain the list of codes that display in 
the Fee Codes pop-up list in the Fees atom. Users can select codes from 
this list as they add fees charged to students; the fee description, fee 
amount, and fee type assigned to each code is entered automatically.
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Adding Fee Codes to the List

1. Open the Fee Codes atom.

2. Select Add Fee Code from the Data menu. The program displays a 
new line number.

3. In the Code field, type a numeric code for a fee.

4. In the Description column, enter a description for the fee.

5. In the Fee column, type the dollar amount of the fee.

6. In the Type column, select a fee classification from the pop-up list.

7. Click Save to save the code.

Deleting Codes from the Fee Codes List

1. Open the Fee Codes atom.

2. Click the Ln number for a fee code to highlight its row.

3. Select Delete Fee Code from the Data menu. The row for the fee code 
is removed from the list of fee codes in the matrix. If you delete any 
row but the last, remaining rows are renumbered and repositioned to 
fill in the gap.

4. Click Save to permanently delete the code from the fee codes list.

Fee Codes Fields

Field Description

Ln Line number for each row.

Code Fee code, up to six alphanumeric characters. 
This code is available from a pop-up field 
when you add fees in the Fees atom.

Description Up to 15 characters describing the fee (for 
example, Cap and Gown).
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Fee Dollar amount of the fee due from the 
student. Enter up to a 6-digit number, 
including two decimal places (for example, 
9999.99 is the maximum fee amount).

Note: You can leave this field blank and add 
the fee to the student later.

Type Select from a pop-up list of possible fee 
types. This list must be defined in the Fee 
Type (FTY) table, using the Tables Definition 
atom.

Field Description
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Using the Locker Atom

You can use the Locker atom (in the Non-Student Info folder) to record and 
view a variety of data for each locker, including:

! Lock combinations
! Padlock numbers
! Locker location, condition, and type
! The student or students a locker is assigned to

Data on locker assignments is stored in the ALKA file. However, locker 
assignment data is displayed in both the Locker and Student atoms.

You can add locker records at the beginning of the school year or as 
needed throughout the year. You can also change or delete locker records 
at any time.

Data Menu Functions in the Locker Atom

Using options on the Data menu, you can Find, Add, and Delete locker 
records.

Locker Menu Options

Menu Description

Assignment Report
(LKR01)

The Assignment Report prints a locker 
assignment slip that lists the student name 
(first, middle, and last), grade, student ID, 
date, school name and year, locker number, 
and the current year’s locker combination. 
The report prints three students per page, on 
plain or perforated paper.

Unassigned Lockers
(LKR02)

The Unassigned Lockers report prints the 
locker number, gender restriction, minimum 
and maximum grade restrictions, number of 
students allowed per locker, locker condition, 
out-of-use status, and reserved status for 
each unassigned locker.
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Students w/o Lockers
(LKR03)

The Students w/o Lockers report prints the 
student name (first, middle, and last), grade, 
and student ID for all students who have not 
been assigned to a locker.

Change Locker Number Change a locker number assigned 
previously. Normally, the Locker # field is 
locked to prevent accidental change.

Mass Assign Lockers Assign a group of lockers to multiple students 
by grade or grade range, gender, and/or 
student group. You can also reserve lockers 
and clear previous locker assignments.

Convert Old Locker Data Runs a utility that converts existing locker 
assignment data from Page 2 of the Student 
atom (from the ASTU file) and from previous 
versions of the Locker atom (from the ALKR 
file) to the format required by the Locker atom 
in the SASIxp educational software (the new 
ALKA file). The ALKA file is now used to 
store all locker assignment data.

Note: You only need to run this utility if you 
want to preserve locker assignments 
made in previous versions of the 
SASIxp educational software.

Menu Description
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Locker Screen

Use the Locker screen to view and change one locker at a time. The Mass 
Assign Lockers function enables you to perform global changes on all 
lockers. See the Basic Applications Training Guide for more information 
regarding Mass Assign Lockers.

Modifying Locker Records

Use the following procedures to add, change, and delete lockers.

Adding a Locker Record

1. Open the Locker atom. The Locker screen displays.

2. From the Data menu, select Add Locker.

3. In the Locker # field, type a unique number for the locker (you can 
enter up to seven characters). Then tab to each remaining field, and 
enter data as needed.

4. When you finish entering data, click Save to save the locker record. 
The new locker number displays in the title bar.

You must enter hyphens between each element of the locker 
combination. Hyphens or slashes are not required for entering dates 
or phone numbers.
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Changing a Locker Number

1. Open the Locker atom and bring up the record you want, using any of 
the methods available, including Find.

2. From the Locker menu, select Change Locker Number. The Locker # 
field is highlighted.

3. Type a new locker number. The old entry disappears as you type. You 
can also click to the right of the part of the number you want to replace, 
backspace over it, then begin typing.

4. If you want to make changes in any other fields, tab to those fields and 
enter data.

5. When you finish entering data, click Save to save ALL new entries. 
The new locker number displays in the title bar.

Deleting a Locker Record

1. Open the Locker atom and bring up the record you want to delete 
using any of the methods available, including Find.

2. From the Data menu, select Delete Locker. All data is cleared from the 
screen and the locker record is removed from the database.

Locker Fields

You must enter a unique number for each locker.

Field Description

Locker Number that displays on a locker or the 
number assigned to the locker by the school.

Height Locker's position in relation to other lockers:

! Upper
! Middle
! Lower
! Unknown

Type Locker's type, such as Girl's Gym Locker, 
Large Book Locker. (List from LKT Table)
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Location Locker's location in the school or on the 
campus.

Students Number of students that can be assigned to a 
locker. It can be either 1, 2, or the number 
defined as the default in the School atom.

Note: Adding a student to a locker record 
also adds the locker number to the 
student record in the Student atom.

Padlock# Number of any padlock assigned to a locker 
or the students using a locker.

Gen Any gender restriction on use of a locker:

! Male Only
! Female Only
! No Restriction

Low Lowest grade for which a locker can be used. 
(List from GRD Table)

High Highest grade for which a locker can be 
used. (List from GRD Table)

Combinations
1 — 5

Number combinations that unlock a locker. 
Each field holds one combination.

Student 1 Permanent ID number for the student a 
locker is assigned to.

Student 2 Permanent ID number for any student 
sharing a locker with the first student.

Condition
(LKC Table)

Condition of a locker at the time it is 
assigned. Conditions might include New, 
Good, Bad, and Unusable (the list is school-
defined).

Out of Use Indicates whether a locker is out of use due 
to damage or other reasons.

Reserved Indicates whether a locker is reserved.

Field Description
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Options for Assigning Lockers

Options for Clearing Locker Assignments

Use Combination Combination you want to use for the locker. 
You can use any of the five combinations 
listed above or the default from the school 
file.

Field Description

Option Description

Don't use reserved
lockers

Skip lockers with a status of Reserved during 
the assignment process (only assign 
Available lockers).

Use reserved lockers
only

Skip lockers with a status of Available during 
the assignment process (only assign 
Reserved lockers).

Ignore locker reserved 
status

Assign lockers regardless of their reserved 
status.

Allow 2 students
per locker

Whether the locker can accommodate two 
students. Choices include No, Yes - If Locker 
Allows 2, or Yes - All Lockers. When 
assigning lockers, the SASIxp educational 
software checks the status of this field to see 
if the setting has been changed. If not, the 
SASIxp educational software then checks the 
same field in the School atom.

Option Description

Clear default
combination overrides

Resets the value of the Use Combination 
field in the Locker atom to the default from 
the school file.

Reserve if no other 
assignments

Changes the status of a locker to Reserved if 
the locker is not Out of Use or assigned to 
another student.
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Mass Assign Lockers Function
You can mass assign lockers to multiple students at one time based on 
student grade, gender, or student group. You can also reserve lockers and 
clear previous locker assignments.

The Mass Assign Lockers function is available from the Locker atom (in 
the Non-Student Info folder).

Mass Assign Lockers Screen

Mass Assigning Lockers

1. Open the Locker atom.

2. From the Locker menu, select the Mass Assign Lockers option. The 
Mass Assign Lockers screen displays.

3. Select the Assign Lockers option.

4. In the Grade, Gender, or Group fields, select students to whom you 
want to assign lockers.

NCS recommends that no other users be active on the SASIxp software 
when you use the Mass Assign Lockers function.
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5. In the Locker # fields, select the range of locker number to assign to 
selected students.

6. In the Options area, select a check box for handling reserved lockers.

7. In the Allow 2 Student per Locker field, select whether you want two 
students to be assigned to each locker from the pop-up list.

8. Click Assign to mass assign lockers to selected students (or click 
Close to abandon locker assignment).

Reserving Lockers

You can reserve one or more available lockers for future assignment to 
students.

1. Open the Locker atom.

2. From the Locker menu, select Mass Assign Lockers.

3. On the Mass Assign Lockers screen, select the Reserve Lockers radio 
button.

4. In the Locker # fields, enter the range of locker numbers to be 
reserved.

5. Click OK to reserve lockers, or click Close to close the atom without 
reserving lockers.

Clearing Locker Assignments

You can clear assigned lockers at any time.

1. Open the Locker atom.

2. From the Locker menu, select Mass Assign Lockers.

3. On the Mass Assign Lockers screen, select the Clear Locker 
Assignments radio button.

4. In the Options box, select one or more of the following:

! Clear default combination overrides: Resets the value of the Use 
Combination field in the Locker atom to the default from the school 
file.

! Reserve if no other assignments: Changes the status of a locker to 
Reserved if the locker is not Out of Use or assigned to another 
student.

The SASIxp software does not reserve lockers in the selected range 
that are already assigned to students.
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5. If you want to clear locker assignments for a specific grade, gender, or 
student group, select the Student Selection check box, then select 
your choices in the Grade, Gender, and/or Group fields.

6. In the Locker # fields, enter a locker number or range of locker 
numbers to be cleared. 

7. Click OK to clear assigned lockers, or click Close to close the atom 
without clearing locker assignments.

Mass Assign Locker Fields

Action

Student Selection

If you make an entry in just the first field, the system clears lockers 
with a number greater than or equal to the number entered. If you 
make an entry in just the second field, the system clears lockers with 
a number less than or equal to the number entered. If you make an 
entry in both fields, the system clears lockers with a numbers equal to 
and between the numbers entered. If you leave both fields blank, the 
system clears all lockers.

Field Description

Assign Lockers Select this option to assign specified lockers 
to specified students or student groups.

Clear Locker 
Assignments

Select this option to clear the assignment 
status of specified lockers.

Reserve Lockers Select this option to change the status of 
lockers from Available to Reserved (a locker 
is not reserved if the Out of Use checkbox is 
selected for the locker in the Locker Atom).

Field Description

Grade The grade or grade range to which you want 
to assign lockers.
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Locker Selection

Options

Gender The gender to which you want to assign 
lockers.

Group The student group to which you want to 
assign lockers.

Field Description

Locker # … to … The range of lockers you want to reserve, 
assign, or clear.

Field Description

Don’t use reserved 
lockers

Displays only if you choose the Assign 
Lockers option. Select this option to skip 
lockers with a status of Reserved during the 
assignment process (the system only assigns 
Available lockers).

Use reserved lockers 
only

Displays only if you choose the Assign 
Lockers option. Select this option to skip 
lockers with a status of Available during the 
assignment process (the system only assigns 
Reserved lockers).

Ignore locker reserved 
status

Displays only if you choose the Assign 
Lockers option. Select this option to assign 
lockers regardless of their reserved status.

Field Description
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Allow 2 students per 
locker

Displays only if you choose the Assign 
Lockers option. Indicates whether the locker 
should accommodate two students. When 
assigning lockers, the SASIxp educational 
software checks the status of this field to see 
if the setting has been changed; if not, 
SASIxp then checks the same field in the 
School Atom. Choices are:

! No
! Yes – If Locker Allows 2
! Yes – All Lockers.

Clear default combination 
overrides

Displays only if you choose the Clear Locker 
Assignments option. Resets the value of the 
Use Combination field in the Locker Atom to 
the default from the school file.

Reserve if no other 
assignments

Displays only if you choose the Clear Locker 
Assignments option. Changes the status of a 
locker to Reserved if the locker is not Out of 
Use or assigned to another student.

Field Description



Using the Locker Atom

186  Mass Assign Lockers Function Copyright © 2004 Pearson School Systems



Copyright © 2004 Pearson School Systems  187

Using the Label Definition Atom

The Label Definition atom (in the System Setup folder) enables you to 
define your own label formats to use with the label printing feature in the 
Query atom. 

Label Definition Screen

The label formats you define here display on the pop-up list of label 
formats available from Query. 

Working with Label Definitions

Use these procedures to define your own label formats to use with the 
label printing feature in the Query atom.

Adding a Label Definition

1. Open the Label Definition atom.

2. Select the Add Definition option from the Data menu.
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3. In the Label Name field, type the name for this label definition.

4. In the Label Num field and enter a number.

5. In the Top Margin and Left Margin fields, enter the top and left margins 
for the label. 

6. Fill in the remaining fields on the screen, then click Save to save this 
new label definition.

Modifying a Label Definition

1. Open the Label Definition atom.

2. Locate the label definition you want to modify by using Find or clicking 
the advance arrows.

3. Make any changes that are necessary, then click Save to save the 
changes.

Deleting a Label Definition

1. Open the Label Definition atom.

2. Locate the label definition you want to delete by using Find or clicking 
the advance arrows.

3. Select the Delete Label Def option from the Data menu. The definition 
is removed from the system.

Label Definition Fields

The measurements for the top margin and left margin should be equal to 
the distance from the top and left edges of the paper to the top and left 
edges of the label.

Field Description

Label Name Name of the label you are defining, such as 
3 up, 2 up.

Label Num Number identifying this label definition.

Top Margin Area between the top edge of the label page 
and the first label.
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Left Margin Area between the left edge of the label page 
and the labels.

X Delta Area between the labels horizontally.

Y Delta Area between the labels vertically.

Across Number of labels across the page.

Down Number of labels down the page.

Width Width of each label.

Height Height of each label.

CPI Characters per inch.

LPI Lines per inch.

Field Description
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Validating System Setup

The System Validation atom (in the Utilities folder) enables you to print and 
validate the setup of your overall system or the setup of one or several 
modules. You can print the information to a text file or printer.

In addition, you can fax or e-mail the system validation information to the 
SASIxp Support Department for use as a diagnostic tool in resolving 
problems.

System Validation Screen

Using the System Validation Atom

1. Open the System Validation atom.

2. Select the Print Setup Information option.

3. To print, set the Check column to Yes for the setup information you 
want. By default, all modules are set to print.

! To print overall system setup information, set the Check field to Yes 
for General System, then click Print.
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! To print setup information for a module, set the Check field to Yes 
for the appropriate module name and click Print.

! After selecting Print, you can select whether you want to print to a 
text file or printer.

4. Click Close to exit.

System Validation Screen Fields

Field Description

Print Setup Information This option enables you to print setup 
information for your overall system or for 
selected modules.

Check For Errors In 
Setup

Enables you to validate your overall system 
setup or the setup of one or more modules.

Module Lists all the modules currently installed.

Check Selecting Yes in this column indicates that 
the module is set to be printed or validated.



Copyright © 2004 Pearson School Systems  193

Using the System Admin Atom

The System Admin atom (in the Utilities folder) enables you to view the 
users logged on to the SASIxp software, send messages to them, and log 
them out.

System Admin Menu Options

Option Description

Broadcast Message Opens the Send Mail window so you can 
send a message to all users who are 
currently logged in and displayed in the 
window.

Send Message Opens the Send Mail window so that you can 
send a message to the user you have 
highlighted.

Log User out of the 
SASIxp educational 
software

Forces the logout of users that you highlight 
in the System Admin window.

Refresh User List Rechecks the system for active users and 
displays a current listing.
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System Admin Screen

Working with System Admin

Use these procedures to work with the System Administration atom.

Checking Logged-On Users

Open the System Admin atom. Any users who are currently logged on to 
any of the schools using the SASIxp software display on the screen.

Logging Out a User

1. Open the System Admin atom.

2. Highlight the row for the user you want to log out by clicking the line 
number. You can select multiple users by holding down the Shift key as 
you click each line number.

3. Select Logging Out a User from the System Admin menu. When the 
confirm message displays, click OK. The selected users are logged out 
of the SASIxp software.
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Sending a Message to One User

1. Highlight the name of the recipient of your message.

2. Select the Send Message option from the System Admin menu. The 
Send Mail window displays.

3. Complete the Send Mail fields and click Send. The message is sent to 
the In folder of the user shown in the To field.

Sending a Message to All Users Currently Logged In

1. With the System Admin atom open, select the Broadcast Message 
option from the System Admin menu. The Send Mail window displays.

2. Complete the Send Mail fields and click Send. The message is sent to 
all users who are currently logged in and displayed on the screen. The 
users’ In Folder icon displays a small red arrow to indicate that they 
have a message.

3. Click Close.

System Admin Fields

Field Description

User ID SASIxp user ID for each user.

User Name Name of each user.

Class User class (if any) that each user belongs to.

Year Year that the user is logged on to.

School School the user is currently logged on to.

Num of Logins Number of times this user has logged into the 
SASIxp software.
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Standard SASIxp Header Fields

Standard SASIxp Header Fields

Student Header Fields
The fields in this table contain the header information for student 
demographics in the SASIxp software. Header fields are located at the top 
of the screen in a standard format. You initially enter the header data 
contained in these fields using the Enrollment atom.

On all screens, except the Student atom and Enrollment atom, these fields 
are read-only. The header information fields begin with Last Name and 
end with Student ID.

Field Name Description

Last Name Student’s last name.

First Name Student’s first name.

Middle Name Student’s middle name.

Gnrtn Student’s generation code, such as Jr. or Sr. 
This field is not available on all atoms.

Grd Student’s grade.

Gen Student’s gender.

Trk Attendance track to which a student is 
assigned. This field only displays in schools 
using a track schedule.

Student ID Student’s ID number.
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Course Header Fields
The fields in this table contain the header information for courses in the 
SASIxp software. Header fields are located at the top of the screen in a 
standard format. You initially enter the header data contained in these 
fields using the Course atom. See Using the Course Atom.

On all screens, except for the Course atom, these fields are read-only. The 
header information fields begin with Course ID and end with Duration.

Teacher Header Fields
The fields in this table contain the header information for teacher 
demographics in the SASIxp educational software. Header fields are 
located at the top of the screen in a standard format. You initially enter the 
header data contained in these fields using the Teacher atom. See Using 
the Teacher Atom.

On all screens, except the Teacher atom, these fields are read-only. The 
header information fields begin with Last Name and end with Tch ID.

Field Name Description

Course ID Course identification number.

Course Title Course title.

Long Course TItle Long course title.

Duration Duration of the course.

Field Name Description

Last Name Teacher’s last name.

First Name Teacher’s first name.

Middle Name Teacher’s middle name.

Gnrtn Teacher’s generation.

Soc Sec No Teacher’s Social Security Number.
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School Header Fields
The fields in this table contain the header information for schools in the 
SASIxp software. Header fields are located at the top of the screen in a 
standard format. You initially enter the header data contained in these 
fields using the School atom. See Using the School Atom.

On all screens, except the School atom, these fields are read-only. The 
header information fields begin with Sch# and end with Telephone.

Tch ID Teacher’s system-assigned identification 
number.

Field Name Description

Field Name Description

Sch# School number.

School Name School name.

Alternate# School alternate number.

Sch Abrv School abbreviation.

Telephone School telephone number.
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